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Introduction

This User’s Reference Guide explains how to use your D/A1 size or AO+/E+ size HP DesignJet 800PS Printer.
The Introduction Tab contains these topics:
» Using this Guide

Contains information on how to use this guide. There is an explanation of when you should use it and what
each of the navigation buttons do when you click on them.

* Introducing Your HP DesignJet 800PS Printer
Contains a brief overview of the printer. It contains information about the printer’s features and what is
included with the printer.

e Front View of Printer
Contains a view of the front of the printer showing the location of the printer's consumable items.

» Printer Connections
Shows all the connections to the printer: power, parallel interface, USB and network interface.
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Using this Guide
These topics detail the contents of the User's Reference Guide, provide information on associated publications
and give the source of any other related material concerning your printer.

* How to Use this Guide
Explains how to use and navigate through the User's Reference Guide.

* Related Information
The associated publications and information that are available for your printer.
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How to Use this Guide

This User’s Reference Guide explains the details for using both the D/Al size and AO+/E+ size
HP DesignJet 800PS Printers.

This guide is designed as a detailed reference guide to your printer. For more day-to-day guidance you can refer
to the Pocket Guide. This can be found in a slot at the right side of the printer.

The “Tabs”

There are seven “Tabs” at the top of this guide. Each tab contains information about the printer. The first page of
every tab will explain what information you can expect to find and where to obtain related information.

The Buttons

To navigate around the User’'s Reference Guide use the buttons on each side of the screen. See User’s Reference

Guide Navigation.

Animation
In some cases there is an animation that shows you how to perform the procedure.

Click on this button to start the animation.

Related Topics
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Related Information

» The Assembly and Set-up Poster
Step-by-step information on how to prepare your
printer for use (came with your printer).

* The Pocket Guide
Information that you are most likely to need for
printer operation on a day-by-day basis, such as
loading paper or replacing ink supplies (came
with your printer and located in a slot on the right
hand side of the printer).

* The Repacking Poster
Detailed instructions on how to repack you
printer its original packing
(available from www.hp.com/go/designjet).

* Web Page
Also you can visit us on our web page: www.hp.com/go/designjet.

Pocket Guide location



http://www.hp.com/go/designjet
http://www.hp.com/go/designjet
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User’s Reference Guide Navigation

The buttons on each side of the screen allow you to rapidly navigate though this document.

Home To return to the Welcome Screen of To leave this document and quit the Exit
the Using Your Printer CD-ROM, Acrobat Reader application, click the
click the Home button. Exit Button.

Back To retrace your path within this To print pages of the document, click Print
document, click the Back button. the Print button.

Previous Page To go to the previous page, click the To go to the next page, click the Next Next Page
Previous Page button. Page button.
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Introducing Your HP DesignJet 800PS Printer

Your Printer's Main Features
A general overview of the major features of your printer.

HP Ink Supplies
A description of the HP Ink Supplies required for your printer.

Print Resolution
Specifications of the print resolution for your printer.

Media
A description of the different types of media available for your printer.

User Interface
A description of the printer’s user interface.

Memory
Details of internal memory and memory options available with your printer.

Drivers
Details of the drivers delivered with your printer.

Index
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Your Printer's Main Features

The HP DesignJet 800PS printing system is specially designed for medium work-groups in the advertising
agencies, in-house graphic departments that specialize in packaging, point-of-sale material and event signs as
well as all other graphics applications.

For the complete printing solution, HP also offers a wide range of media including HP Satin Poster Paper, ideal for
retail point-of-purchase signs and special occasion posters as well as HP High-Gloss Photo Paper, designed to
produce best quality images with an ultra-smooth glossy finish. And with the HP Complementary Media Program,
HP provides users with a wide spectrum of choice and flexibility in their media selection.

The HP DesignJet 800PS printer comes in two sizes: AO+/E+ size (42 inches/1066.8 mm) and D/Al size
(24 inches/609.6 mm) models. Both models have roll-feed capabilities. The AO+/E+ size model also includes legs
and a media bin.

« Ultimate Photo Image Quality: The HP DesignJet 800PS printing system has a true resolution of up to
2400x1200-dpi on glossy paper, enabling graphic designers to proof, print and present (from letter to poster
size) the ultimate in photo image quality. Light pastels to natural skin tones and bright, vivid colors are
achieved using the HP one-half inch/12.7mm wide printhead combined with HP color layering technology. In
addition, the HP DesignJet 800PS provides excellent line quality.

» Color Accuracy: The HP DesignJet 800PS printer reproduces accurate colors without any manual calibration
or adjustment. Color emulation and Automatic PANTONE calibration mean that graphic professionals can
work efficiently without having to retouch colors. In addition, the HP DesignJet 800PS printer automatically
substitutes CMYK values for PANTONE values.

More...
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Connectivity: The HP DesignJet 800PS printer includes PostScript drivers for Macintosh and Windows and
HP-GL/2 drivers for AutoCAD® and Windows. In addition, the printer includes USB and Parallel ports and a
powerful HP JetDirect 10/100 Base-TX network card. Using the network card, the data from the graphic
professional’s computer is transferred to the “virtual computer”, an internal PostScript RIP, within the

HP DesignJet 800PS printer and immediately frees the data from the computer while processing it quickly.

Speed: The HP DesignJet 800PS printer delivers speeds of 85ft?/hour, and color images on glossy media
are printed up to two times faster than its predecessor, the HP DesignJet 700 series printers. Because the
printer contains a virtual computer and printing is continuous, data is received by the network card and quickly
processes and prints using embedded processors and large memory (160MB RAM and 6GB hard disk)
included within the printer.

Complementary Media Program (CMP): The CMP helps HP customers grow their businesses by referencing
third-party printing material choices to ensure maximum HP DesignJet printer flexibility and printing solutions.
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HP Ink Supplies

HP Ink Supplies for your printer contain two components: printheads and ink cartridges. Your
HP DesignJet 800PS printer uses the following HP Ink Supplies:

» Black Ink Cartridges are HP No 10 Supplies.

* Cyan, Magenta and Yellow Cartridges are HP No 82 Supplies.

e All Printheads are HP No 11 Supplies.

Each 600-dpi thermal inkjet printhead applies thousands of ink droplets onto the paper. The printer automatically
refills the printhead as it prints, enabling continuous uninterrupted printing. The ink is supplied to each printhead
from a separate large capacity ink cartridge.

There is more information available in a pamphlet which comes with the printheads and in Print Times for a
Selected Print Quality.
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Print Resolution

Your HP DesignJet 800PS printer provides two different print modes that change the print resolutions of each of
the print quality modes. These different print modes are optimized for: Line Drawings/Text or Images.

You can then choose between three levels of print quality for each of the print modes: Best, Normal or Fast from
your software or from the printer's front panel.

With the best mode selected you have an additional selection available to provide maximum detail for your printed
image by increasing the resolution of your job above the default resolution.

Print Quality Setting Optimized for Line Drawing/Text Optimized for Images
Resolution in dpi Resolution in dpi
Render Halftone Render Halftone
Fast 300x300 600x300 150x150 600x300
Normal 600x600 600x600 300x300 600x600
Best (default) 600x600 600x600 600x600 600x600
Best (maximum detail) 600x600 1200x600 1200x1200 2400x12002

a. Glossy Photo Media Only

Use Fast to get draft copies of your prints at maximum throughput. Normal is optimized so
that you get the best line quality with the fastest throughput. Select Best if you want to get the
best quality for images and renderings.
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Media

You can print on roll media or sheet media up to 42inches (1066.8 mm) wide with the AO+/E+ size
HP DesignJet 800PS printer and up to 24 inches (609.6 mm) with the D/A1 size model.

The following media types are supported on the HP DesignJet 800PS printer:

* HP Bright White Inkjet Paper (Bond) * HP Paper-Based Semi-Gloss
e HP Vellum e HP Clear film

* HP Natural Tracing Paper e HP Translucent bond

» HP Coated Paper e HP Studio Canvas

* HP Heavyweight Coated Paper + HP Satin Poster Paper

* HP Matte film e HP Banners with Tyvek®

* HP High-Gloss Photo Paper » HP Colorfast Adhesive Vinyl

« HP Semi-Gloss Photo Paper
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User Interface

The printer’s front panel includes an easy-to-use interface with a display, giving you access to a comprehensive
set of printer functions.

Job management manu

& el

Readw 'ﬁl

See Navigating the Menu System, for a short tutorial to teach you how to navigate through the menus and a
description of internal prints.
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Memory

The D/A1 size and AO+/E+ size HP DesignJet 800PS printers come with 160MB of Random Access Memory
(RAM) memory. In addition to this memory, the printer has a 6GB internal hard disk drive used as extended
memory for PostScript and HP-GL/2 rendering and print management.
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Drivers

Always use the right driver (configured correctly) for the combination of your application software and your printer
to ensure that your printer prints exactly what you were expecting in terms of: size, position, orientation, color and

quality.

NOTE: Many software applications include their own drivers.
Your HP DesignJet 800PS printer comes supplied with:

* Adobe PostScript® drivers for Macintosh® (QuickDraw ™)

* Adobe PostScript® drivers for Microsoft® Windows™ applications
* Windows drivers

* AutoCAD drivers for Windows.

NOTE: If AutoCAD drivers are available for the specific AutoCAD release you are using, it is strongly
recommended that you install them to print from AutoCAD.
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Front View of Printer
Ink Cartridge
Power Printhead Front Panel

Switch/Indicator
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Printer Connections

Your HP DesignJet 800PS printer can be connected .

directly to your computer via the traditional parallel Connection

interface or through the Universal Serial Bus (USB) \
port.

For Local Area Network (LAN) connection your
printer has an HP JetDirect Print Server Fast
Ethernet 10/100 base TX network interface card.

See the Assembly and Set-up Poster for information
on connecting your printer to a computer or network.

Power socket /(/( \

Parallel Port Connection USB Connection
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Media & Ink

The D/Al size and AO+/E+ size format HP DesignJet 800PS Printers use a variety of media. The recommended
media is engineered to use with your printer and your printer’s ink system to give you the best results.

The Media & Ink Tab contains these topics:

» Media Choice explains how to choose the correct media type. Choosing the correct paper type for your needs
is an essential step in ensuring good image quality.

* Roll Media details the procedures used for loading and unloading your roll media.
» Sheet Media details the procedures used for loading and unloading your sheet media.

* Ink System gives you an overview of the printer’s ink system, with some warnings and precautions for it's
optimum use.

» Ink Cartridges details the procedures used for: obtaining information, interpreting errors, checking levels and
replacing ink cartridges.

» Printheads details the procedures used for: obtaining information, interpreting errors, replacing printheads
and aligning printheads.
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Media Choice

Choaosing Paper or Other Media

Your printer supports several types of paper. Choosing the best paper type for your needs is an essential
step in ensuring good image quality. These topics help you to select the best media for your particular printing
task.

Paper Types
Detailed information concerning the different types of media available for your printer. This includes

information on: the types of paper supported, their physical characteristics, quality selection, handling and
how to obtain information.

Print Times for a Selected Print Quality
Typical Printing Times for color and black lines and images on different types of paper.

Printable Area
The dimensions for all the printable areas for all paper and other types of media formats.

ICC Profiles
Instructions for downloading International Color Consortium (ICC) device profiles.
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Choosing Paper or Other Media

For best printing results, use only genuine Hewlett-Packard paper or other type of media, whose reliability and
performance have been developed and thoroughly tested. All Hewlett-Packard printing components (printer, ink system,
and paper/other media) have been designed to work together to give trouble-free performance and optimal image
quality. For detailed information on Hewlett-Packard paper, see Paper Types.

You should also take note of some important points about paper and other types of media:

» This printer supports many types of paper. However, the quality of some images may be reduced if you do not
use the correct paper for your application. For example, images with large regions of intense color, where
many ink drops are needed to fully saturate the color, will not print well on HP Bright White InkJet Paper. On
HP Coated paper, the same images might cause the paper to wrinkle and then come into contact with the
printheads, smearing your print and risking damage to the printhead. See Combinations of Media Type and
Print Quality Selection.

* Whenever you load a roll or a sheet, the printer’s front-panel display prompts you to specify the paper type you
are loading. It is absolutely essential to specify this correctly for good image quality. The Physical Characteris-
tics of Paper Types table gives you all the information you need. If paper is already loaded and you are unsure
which paper type was specified, go to the Paper Menu and press Enter; see Obtaining Roll or Sheet Paper
Information.

* Make sure the appropriate print-quality setting (Best, Normal or Fast) is selected. You can set the print qual-
ity either from your software or from the printer’s front panel (software driver settings override any print-quality
settings made on the front panel). The combination of paper type and print-quality settings tells the printer
how to place the ink on the paper—for example, the ink density, dithering method, and number of passes of

the printheads. For more details, see Combinations of Media Type and Print Quality Selec-
tion.

¢ Included with this printer is the Hewlett-Packard Printing Materials catalog which gives
ordering details for Hewlett-Packard paper supplies. To get the latest version of this docu-
ment, contact your local Hewlett-Packard Sales and Support office.
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Paper Types

The following topics address the various types of media available, their particular use and how to obtain
information about them.

» Physical Characteristics of Paper Types
Details the physical characteristics of each of the supported paper types.

» Combinations of Media Type and Print Quality Selection
Gives guidelines for selecting the correct Print Quality selection for the type of paper or other type of media
you are using.

» Handling Your Paper or Type of Media
Explains the precautions to take when handling paper or other type of media.

» Obtaining Roll or Sheet Paper Information
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Physical Characteristics of Paper Types

The following table lists the physical characteristics and selection numbers of supported HP Premium Printing
Material. Always print on the image side with the special coating. Image side faces outward on roll products from
Hewlett-Packard.

Physical Characteristics of Paper and Other Media

HP Premium Printing Material éfolr;f::] 9354”:::] 1‘:')%;”;%
HP Bright White Inkjet Paper (Bond) C1860A2 |C1861A2
24 Ib. (90g/m2) - 150 ft. (45m) C6035AP | CE036AP
HP Vellum C3862A |C3861A
3 mil (75g/m2) - 150 ft. (45m)
HP Natural Tracing Paper C3869A |C3868A
3 mil (90g/m2) - 150 ft. (45m)
HP Coated Paper C6019B | C6020B |ce559B2
26 Ib. (98g/m2) - 150 ft. (45m) Cc6567BP
HP Heavyweight Coated Paper C6029C |C6030C |C6569C
35 Ib. (130g/m2) - 100 ft. (30m)
HP Matte film 51642A 51642B
5 mil (198g/m2) - 120 ft. (36m)
HP High-Gloss Photo Paper C6813A |C6814A
8 mil (207g/m2) - 100 ft. (30m)

Click on the Next Page Icon to see more Paper and Other Media Types




Introduction

Solutions Front Panel

Printer
Options

Other

Physical Characteristics of Paper and Other Media (Continued)

. o . 24 inch 36 inch 42 inch
HP Premium Printing Material 610 mm | 914 mm | 1067 mm
HP High-Gloss Photo Paper C3882A |C3881A
6 mil (158g/m2) - 100 ft. (30m)
HP Semi-Gloss Photo Paper C3884A |C3883A
6 mil (158g/m2) - 100 ft. (30m)
HP Paper-Based Semi-Gloss C6782A |C6783A
6 mil (158g/m2) - 100 ft. (30m)
HP Clear film C3876A |C3875A
4 mil (174g/m2) - 75 ft. (22m)
HP Translucent bond C3860A |C3859A
3 mil (67g/m2) - 75 ft. (45m)
HP Studio Canvas C6771A
20 mil (368g/m2) - 35 ft. (10m)
HP Satin Poster Paper C7011A
5.5 mil (162g/m2) - 100 ft. (30m)
HP Banners with Tyvek® C6786A |C6787A
10 mil (140g/m2) - 50 ft. (15m)
HP Colorfast Adhesive Vinyl C6775A

10 mil (140g/m2) - 50 ft. (15m)

a. Available in United States, Canada and Latin America

b. Available in Europe, Asia and Japan

Additional Information About Paper Types

Index
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Additional Information About Paper Types

The following HP Premium Printing Material can be used to perform the printhead alignment, see Printhead
Alignment.

» HP Bright White Inkjet Paper (Bond)

* HP Coated Paper

* HP Heavyweight Coated Paper

* HP High-Gloss Photo Paper

» HP Satin Poster Paper

You can also use Plain Paper in addition to the above.

To order any of the HP Premium Printing Material, see the pamphlet Hewlett-Packard Printing Materials.

From time to time, new paper types may become available. For up-to-date information, please contact your
Hewlett-Packard dealer, local Hewlett-Packard Sales and Support Office or the DesignJet Online web site.



http://www.designjet-online.hp.com/
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Combinations of Media Type and Print Quality Selection

Use the following tables, given by application, to guide you when choosing your paper and selecting the print
quality setting (Fast, Normal, Best).

e CAD Drawings—Mono
» CAD Drawings and GIS—Color (Lines and low density)
 CAD Rendering, GIS and Images—Color and CAD (high ink density).

As a general guide:
» Fast is best for draft copies of your prints at maximum throughput
* Normal is optimized so that you get the best line quality with the fastest throughput
* Best is for when you want to get the best quality for images and renderings.
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The following table lists the recommended print quality settings for specific usage with typical media.

Solutions Front Panel

Printer

Options Other

Supported Paper Types—Mono

Usage

Typical Media Selection

Recommended Print Quality Setting

Drafts

Plain Paper

Bright Inkjet Paper
Natural Tracing Paper
Translucent Bond

Fast or normal

Final Versions

Plain Paper

Bright Inkjet Paper
Natural Tracing Paper
Translucent Bond
Coated paper

Heavy Coated Paper
Matte Film

Normal or Best

Natural Tracing Paper
Vellum
Matte Film

Clear film
Archives Vellum Best
Matte Film
Clear Film
Diazo Translucent Bond Normal or Best

Index
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CAD Drawings and GIS—Color (Lines and low density)

The following table lists the recommended print quality settings for specific usage with typical media.

Supported Paper Types—Color

Usage

Typical Media Selection

Recommended Print Quality Setting

Drafts

Plain Paper

Bright Inkjet Paper
Natural Tracing Paper
Translucent Bond

Fast or Normal

Final Versions

Plain Paper

Bright Inkjet Paper
Coated paper

Heavy Coated Paper
Matte Film

Normal or Best

Clear film
Archives Matte Film Best
Clear Film
Transparencies | Clear Film Normal or Best

Index
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CAD Rendering, GIS and Images—Color and CAD (high ink density)
The following table lists the recommended print quality settings for specific usage with typical media.
Supported Paper Types—Color and CAD

Typical Media Selection

Recommended Print Quality Setting

Usage
Matte Paper Heavy Coated Paper Normal or Best
Glossy High Gloss Photo Paper | Normal or Best
Transparencies | Clear Film Best
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Handling Your Paper or Type of Media

Take the following precautions when handling paper or other type of media:

» Handle film and glossy paper by the edges or wear cotton gloves. Skin oils can interact with the ink and cause
it to smear.

» Although the ink systems supplied with this printer have good light fastness, colors will eventually fade or
change if exposed to sunlight over a long period of time.

* Rewrap partially used rolls if they are not being used and do not stack rolls.

» Always keep unused rolls in their plastic wrappings to prevent discoloration.



Printer

Introduction Solutions Front Panel Options Other Index

Obtaining Roll or Sheet Paper Information

If roll media or sheet media is loaded, the type of media is displayed when you select the Paper menu on the front
panel.

Bright White Inkjet Paper
Plain Paper

Vellum

Natural Tracing Paper Faper menu
Translucent Bond
Clear Film

Matte Film p High-Gloss Photo
Coated Paper —» |Eoll loaded
Heavy Coated Paper
High-Gloss Photo

Canvas —— Roll or Sheet
Poster Paper

M &

If there is no paper loaded the front panel display shows the following message and you will need to load roll or
sheet media.

Faper meng

Load raoll

Load sheet

Cutter = OH

Fage format
Bduance calibration

W Yk




Printer

Introduction Solutions Front Panel Options Other
Print Times for a Selected Print Quality
The following table lists some typical printing times for D/A1 size paper.
Typical Printing Times
Print Quality Time (in seconds)
. Color Lines Images Images
Mono Lines on Coated | on Coated on Glossy
on Bond
Paper Paper Paper
Fast 69 96 234 480
Normal 216 216 550 690
Best 360 285 940 990

More Printing Times

Index
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Printable Area
The following topics detail the printable areas for each of the different paper size systems:

» ANSI Paper
The American National Standards Institute imperial paper sizing system.

» Architectural Paper
The Architectural paper sizing system.

» ISO Paper
The International Standards Organization metric paper sizing system, which is the size system commonly

used in Europe.
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ANSI Paper

The following table lists the printable area for the ANSI paper size system. The left and right margins are 0.2
inches (5 mm) and the leading and trailing edge margins are 0.7 inches (17 mm).

Where: Printable area = Paper Size — Margins
Printable Areas for ANSI paper

Printable area (width x height) by Image Orientation
Paper Oriegtaetrici’: of Inches Millimeters
size ppr?nter Landscape Portrait Landscape Portrait
Width | Height | Width | Height | Width | Height | Width | Height
A Portrait 9.7 8.1 8.1 9.7 245 206 206 245
Landscape 7.2 10.6 10.6 7.2 182 269 269 182
B Portrait 15.7 10.6 10.6 15.7 398 269 269 398
Landscape 9.7 16.6 16.6 9.7 245 422 422 245
C Portrait 20.7 16.6 16.6 20.7 525 422 422 525
Landscape 15.7 21.6 21.6 15.7 398 549 549 398
D Portrait 32.7 21.6 21.6 32.7 830 549 549 830
Landscape 20.7 33.6 33.6 20.7 525 854 854 525
E Portrait N/A 33.6 42.7 N/A 854 1084
Landscape 327 | 436 N/A 830 | 1108 N/A

Indicates this printable area is only available if you are using the AO+/E+ size format
HP DesignJet 800PS printer
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Architectural Paper
The following table lists the printable area for the Architectural paper size system.

The left and right margins are 0.2 inches (5 mm) and the leading and trailing edge margins are 0.7 inches (17
mm).

Where: Printable area = Paper Size — Margins .

Printable Areas for Architectural paper

Printable area (width x height) by Image Orientation
Paper Oriegtaetrici’: of Inches Millimeters
size ppr?nter Landscape Portrait Landscape Portrait
Width | Height | Width | Height | Width | Height | Width | Height
C Portrait 22.7 17.6 17.6 22.7 576 447 447 576
Landscape 16.7 23.6 23.6 16.7 423 600 600 423
D Portrait 34.7 23.6 23.6 34.7 880 600 600 880
Landscape 22.7 35.6 35.6 22.7 576 904 904 576
El Portrait 40.7 29.6 29.6 40.7 1033 752 752 1033
Landscape 28.7 41.6 41.6 28.7 728 1057 1057 728
E Portrait N/A 35.6 46.7 N/A 904 1185
Landscape 34.7 47.6 N/A 880 | 1209 N/A

Indicates this printable area is only available if you are using the AO+/E+ size format
HP DesignJet 800PS printer
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ISO Paper
The following table lists the printable area for the 1SO paper size system.
The left and right margins are 0.2 inches (5 mm) and the leading and trailing edge margins are 0.7 inches (17
mm).
Where: Printable area = Paper Size — Margins
Printable Areas for ISO paper

Printable area (width x height) by Image Orientation
Paper Oriegtaetrici’: of Inches Millimeters
size ppr?nter Landscape Portrait Landscape Portrait
Width | Height | Width | Height | Width | Height | Width | Height
Ad Portrait 104 7.9 7.9 10.4 263 200 200 263
Landscape 6.9 11.3 11.3 6.9 176 287 287 176
A3 Portrait 15.2 11.3 11.3 15.2 386 287 287 386
Landscape 10.4 16.1 16.1 10.4 263 410 410 263
A2 Portrait 22.0 16.1 16.1 22.0 560 410 410 560
Landscape 15.2 23.0 23.0 15.2 386 584 584 386
Al Portrait 31.7 23.0 23.0 31.7 806 584 584 806
Landscape 22.0 32.7 32.7 22.0 560 830 830 560
AO Portrait N/A 32.7 454 N/A 830 1154

Indicates this printable area is only available if you are using the AO+/E+ size format
HP DesignJet 800PS printer
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ICC Profiles
Using HP-provided ICC Profiles for the media used with your HP DesignJet printer assures optimal color
reproduction on your HP DesignJet 800PS printer. To use an ICC Profile you must first download the profiles.

These profiles can be found for a particular printer’s driver page. Begin by clicking the CD icon for drivers on the
main page of http//www.hp.com/go/designjet and select “Printing Materials.” This will lead you to the drivers and

ICC Profiles for a particular printer.

You download all the ICC Profiles for a specific printer and ink combination in one self-extracting archive. You will
find ICC Profiles for all HP Premium Printing Material media including HP Studio Canvas, HP Colorfast Adhesive

Vinyl, and HP Banners with Tyvek®.
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Roll Media

The following procedures are described in detail, with animations where appropriate:
* Installing a New Roll on the Printer

e Loading Roll Media

» Unloading Roll Media

« Removing Roll Media from the Spindle

o Cutter Replacement
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Installing a New Roll on the Printer

The animation sequence shows how to install a new roll
of paper on the printer.

CAUTION: Make sure the printer wheels are locked
(the brake lever on each wheel is
pressed Down) to prevent the printer
from moving.

If you are a regular user of different types of roll paper,
you can change the paper quicker if you have more
than one spindle. This allows you to do the following:

1. Pre-load the different types of paper onto the spin-

dles.

2. Remove and replace the spindle with the new type
of paper.

NOTE: Additional spindles are available from

Hewlett Packard as accessories.

Click on this icon to run the animation sequence. A printable version of the sequence is also available so

that you can take the key illustrations to the printer, if it is remote from your computer.



Introduction Solutions Front Panel

Loading Roll Media

The animation sequence shows how to load a new roll
of paper on the printer.

NOTE: You must have installed a new roll of
paper on the printer before you can load
it.

The front-panel menu items are:

Select (using the § keys) Then Press:
Paper Enter
Load Roll Enter
Select Roll Type Enter
Click on the icon to run the animation

sequence. A printable version of the sequence is also

available so that you can take the key illustrations to the printer, if it is remote from your computer.

Printer
Options

Other

Index
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Unloading Roll Media

The animation sequence shows how to unload a roll of
paper from the printer.

Click on the icon to run the animation

sequence. A printable version of the sequence is also
available so that you can take the key illustrations to the
printer, if it is remote from your computer.
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Removing Roll Media from the Printer

The animation sequence shows how to remove a roll of
paper from the printer.

NOTE: You must have unloaded the roll of paper
from the printer before you can remove
it.

Click on the icon to run the animation

sequence. A printable version of the sequence is also
available so that you can take the key illustrations to the
printer, if it's remote from your computer.
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Removing Roll Media from the Spindle

The animation sequence shows how to remove a roll of
paper from the roll spindle.

NOTE: You must have removed the roll of paper
from the printer before you can remove it
from the spindle.

Click on the icon to run the animation

sequence. A printable version of the sequence is also
available so that you can take the key illustrations to the
printer, if it is remote from your computer.
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Cutter Replacement

The animation sequence shows the complete
procedure for the replacement of the paper cutter in
your printer.

Prerequisites

Before attempting to replace the cutter you must

contact your local HP_Customer Care center to:

» Order the replacement cutter.

* Receive instructions on how to access the Front
Panel Service Menu.

Important Information

* The cutter unit is attached to the printer by a black
cutter holder that runs along the metal guide ralil,
and is hooked onto the edge of the platen at the
front of the printer.
* The cutting wheel is inside the cutter unit.
* Do not remove the cutter holder.
* When inserting the new cutter, with the cutter holder raised to about 45 degrees, partially insert the cutter so it
rests in the cutter holder, but do NOT clip it in at this stage.

CAUTION: Be very careful when replacing the cutter because you can easily break the cutter holder if you
apply too much force.

Click on the icon to run the animation sequence. A printable version of the sequence

is also available so that you can take the key illustrations to the printer, if it is remote from your
computer.
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Sheet Media

*  Which Side Up?

Instructs you how to identify which side of the sheet media should be printed on.
* Which Edge First?

Explains which edge of the sheet should be loaded first (short edge or long edge).
* Loading Sheet Media

Details the sheet media loading procedure.

* Unloading Sheet Media
Details the sheet media unloading procedure.
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Which Side Up?

The printer prints on the side of the paper that faces up. It may be important to load the sheet with the correct side
facing up. See the table below.

Print Side for Media Types

Media Type Matte or Glossy

HP Bright White Inkjet Paper (Bond) Both sides are the same. If sheet

HP Vellum is curled, load with curl down.

Natural Tracing Paper

Coated Paper Load with the coated side up.

Heavy Coated Paper

Matte Film Load with the matte side up.

High-Gloss Photo Load with the glossy side up.

Clear Film

Translucent Bond Both sides are the same. If sheet
is curled, load with curl down.

Canvas

Poster Paper

Plain Paper Both sides are the same. If sheet

is curled, load with curl down.
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Which Edge First?

You can load sheet paper in either portrait or landscape orientation. Unless you are using the Rotate option,
always load the sheet in the same orientation as you have specified in your software.

If you are printing a PostScript file, always load the sheet with the short edge first, even if the width of your image
is greater than its length.

Landscape (long edge first)

Portrait (short edge first)
—always use for PostScript
files
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Loading Sheet Media

The animation sequence shows how to load a new
sheet of paper on the printer.
Important

» If you have a roll of paper loaded on the printer you
must first unload it from the printer.

» Make sure the correct side of the sheet is facing up
when you load it.

The front panel menu selections are:

Select (using the § keys) Then Press:
Paper Enter
Load sheet Enter
Select Sheet Type Enter
Click on the icon to run the animation sequence. A printable version of the sequence is also available so

that you can take the key illustrations to the printer, if it's remote from your computer.
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Unloading Sheet Media

The animation sequence shows how to unload a sheet
of paper from the printer.
Important

» To give the ink time to dry the printer holds the
paper for some time.

Click on the icon to run the animation

sequence. A printable version of the sequence is also
available so that you can take the key illustrations to the
printer, if it is remote from your computer.

Printer
Options

Other

Index
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Ink System

These topics cover the various elements of the Ink System.

* What are HP Ink Supplies?
Details the elements of the HP Ink Supplies supplies.

» Component identification
Shows you where to find the various elements of the Ink System.

* Ink Supply Guidelines
Explains how to obtain the best results from your Ink System.

» Precautions
Details the specific precautions you must take to avoid damaging the components of your Ink System.

» Color Calibration
Explains how to calibrate the ink system for the type of media loaded

e Drying Time

Explains drying time function and details how to use it to ensure you obtain the highest quality print under all
conditions.
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What are HP Ink Supplies?

For each of the four ink colors used in the printer, there are two separate components, the printhead and the
ink cartridge. These components are called the HP Ink Supplies and are coded with a Hewlett-Packard No.
selection number to help you reorder the correct replacement. Your HP DesignJet 800PS printer uses the
following HP Ink Supplies:

» Black Ink Cartridges are HP No 10 Supplies.

* Cyan, Magenta and Yellow Cartridges are HP No 82 Supplies.

e All Printheads are HP No 11 Supplies.
Ink Cartridges

The Hewlett-Packard ink cartridges for your printer require no maintenance or cleaning. As long as each ink
cartridge is inserted correctly into its slot, the ink will flow to the printheads. Because the printheads control the
amount of ink transferred to the page, you will continue to see high-quality printing results, even when the ink
levels are getting low.

The front panel notifies you when an ink cartridge’s ink level is low. You can also check the ink levels of all the ink
cartridges to determine if an ink cartridge needs to be replaced, see Ink Cartridge Information.

If the ink cartridge is empty, the printer stops printing. See Ink Cartridge Replacement.
Printheads

The Hewlett-Packard printheads are extremely durable and do not need to be replaced every time an ink cartridge
is replaced. They are independent of the ink cartridges and will continue giving excellent
image quality results even if the ink cartridges are low in ink.

If you notice a decline in print quality such as lines or dots missing from text or graphics, see
Stepped Lines.
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Component identification

The following illustration will help you identify the components of the HP Ink Supplies.

Printheads

Ink Cartridges

The Hewlett-Packard selection number on the ink cartridges and printheads makes it easy for
you to find the correct HP Ink Supplies for your printer. Determine the color of the printhead or
ink cartridge you need, then make sure you purchase or order the correct Hewlett-Packard
printhead or ink cartridge. Each ink cartridge and printhead can be purchased separately from
your usual Hewlett-Packard retailer. See Ordering Accessories.
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Ink Supply Guidelines

For optimum results from your printer and the ink system, always follow these guidelines when handling HP Ink
Supplies:

Always install the ink cartridges and printheads before the expiry date, which is on the packaging.
Install ink cartridges and printheads in their color-coded slots.

Follow the instructions on the front panel during installation.

Avoid unnecessary removal of the ink cartridges and printheads.

When turning off your printer, always use the power-off button on the front panel. The printheads are then
parked correctly which prevents them from drying out.

The ink cartridges should never be removed while the printer is printing. They should only be removed when
the printer is ready for you to replace them. The front panel will guide you through the removal and installation
procedure. See When to Replace HP Ink Supplies.

CAUTION: When you first received your printer it was supplied with a set of four setup printheads installed

in the printhead carriage. These setup printheads are used for the priming of the tubes in the
modular ink delivery system. Do not remove the setup printheads from the carriage without
following the procedures in the Assembly and Set-up Poster.
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Precautions

Handle HP Ink Supplies with care. In particular, the printhead, which is a high-precision device, must be handled
carefully.

CAUTION: Do not touch, wipe or attempt to clean the printhead nozzles. This can damage the printhead.

* Do not put the printhead down on the nozzles.

* Do not be rough when handling the printheads.
Always set them down gently.

» Do not drop the printheads. Proper handling will
assure optimum performance throughout the print-
head life.

» Do not touch the end of the ink cartridge which is
inserted into the printer as there may be a small
amount of ink on the connection.

* Avoid storing partly used ink cartridges on their
ends.
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Color Calibration

You can calibrate the ink system for the specific media loaded in your printer. Doing this ensures the printed output
matches the colors of the original image as closely as possible. The printer stores the calibration data for each
type of media you have calibrated it for since it was powered up. Once the printer has been powered down, the
next time you use it only the last calibration made will be available and it will print using this calibration data.

To color calibrate your printer, first make sure you have the correct type of media loaded and then make the
following front-panel selections:

Select (using the § keys) Then Press:
Ink Enter
Color calibration Enter
Calibrate Paper Enter

The printer prints a calibration pattern and scans it to create the calibration data for the type of media loaded.
If you want to check the color calibration status of your printer, make the following front-panel selections:

Select (using the § keys) Then Press:
Ink Enter
Color calibration Enter
Status Enter

The front panel display shows what types of media the ink system is currently calibrated for.

To remove all the calibrations and reset the printer to its factory values choose
Color calibration > Reset from the Ink menu.
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Drying Time
The following topics detail the drying time function and how to use it to ensure you obtain the highest quality print
under all conditions.

* Drying Time Settings
Describes how to set the required drying times from the front panel.

» Typical Drying Times
Lists typical drying times for Hewlett-Packard tested paper at approximately 25°C with 50% relative humidity.

* Drying Procedure
Details how the drying procedure operates.
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Drying Time Settings

With some paper types and environmental conditions the ink needs time to dry before the paper is unloaded. The
printer has three settings which you can choose through the front panel. See Navigation Example for more help.

Manual

The printer holds in place paper which has a specific drying time, and displays a “drying time to go” countdown on
the front panel. You can change this time from one minute to 99 minutes in one minute increments.

Automatic

The printer automatically determines the appropriate drying time, based on the type of paper you have selected
and the current temperature. If there is any drying time the printer displays a “drying time to go” countdown on the
front panel.

None

With this setting, when the printer has finished printing an image, the paper will fall into the paper bin under the
printer.

CAUTION: Changing the drying time to speed up the printer could result in damage to your printed image
or reduce the quality of your print.
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Typical Drying Times
The following table shows the typical drying times for Hewlett-Packard tested paper at approximately 25°C with
50% relative humidity.

Drying Times by Paper Types

Hewlett Packard Tested Paper Drying Time (seconds)
Type Fast Normal Best
HP Bright White Inkjet Paper (Bond) 0 25
HP Vellum
, 60 120 180
HP Natural Tracing Paper
HP Coated Paper 0 60
HP Heavyweight Coated Paper 0 60
HP Matte film 60 180
HP High-Gloss Photo Paper 120
HP Semi-Gloss Photo Paper
HP Paper-Based Semi-Gloss

HP Clear film 60

HP Translucent bond 60 120 180
HP Studio Canvas 6000

HP Satin Poster Paper 60

HP Banners with Tyvek®
HP Colorfast Adhesive Vinyl
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Drying Procedure
The drying procedure operates as follows:

1. The printed image emerges from beneath the printer window and a vacuum holds it on the platen of the
printer.

2. The front panel displays:

The countdown Tob mansgemant menu
timer indicates
how much
drying time ia:'jpg-
; Fik driing
remains 1 mik 5 sec Iﬁ]

You can press the Cancel or the Form Feed & Cut key to cancel the drying time and release the paper.

4. After the drying time has elapsed:
For roll media the printer cuts the media and turns off the vacuum so the printed image can drop into the
printer bin.
For sheet media the vacuum is turned off and the printed image drops into the printer bin.
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Ink Cartridges

Ink Cartridge Errors

Details the error messages that could be displayed on the front panel for the Ink Cartridges.
Ink Cartridge Levels

Details the information about levels that can be displayed on the front panel for the Ink Cartridges.
Ink Cartridge Information

Shows you how to display the current status of the Ink Cartridges on the front-panel display.
Ink Cartridge Replacement

Details the Ink Cartridge replacement procedure.
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Ink Cartridge Errors

The Front Panel can display the following error messages for the ink cartridges:

Cartridges ertror ith daws: 7

AL °| ] =
Cartridge | Iﬁ]
Missing Cartridge
Nearly
Reached RERET %
Cartridges error End of Life  zartridges erraor

=

<l Al =

Faulty {
Cartridge Cartridge

Empty

Ink menu
% Cartridges will expire %
=

[}

Ink menu

[l E [N

NOTE: If a cartridge has actually passed its expiry date, it will be shown as a faulty cartridge and will
have to be replaced.

The printer will also display the Ink Cartridge Levels.
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Ink Cartridge Levels

The Front Panel will tell you when your ink supply is low, very low or empty. This means you know current status of
your HP Ink Supplies all the time:

Ink menu

Ink level= Ink lewel=

LU Wy =

Cartridge 4 Low Ink A

Full Warning

i = G

Ink menu

Cartridges error

Al

NOTE: Depending on type of print jobs, a cartridge with a Low Ink Warning may in
fact last quite a long time (for example, with line drawings).

[l E [N

Cartridge
Empty

NOTE: The Ink Cartridges levels information can also be selected with
Ink menu > Information > Ink Cartridges > Ink Levels if it is not automatically
shown in the Ink menu.
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Ink Cartridge Information

Use the following procedure to display the Ink Cartridge Information screen on the front panel.

The front-panel menu items are:

Select (using the § keys) Then Press:
1. Ink Enter
2. Information Enter
3. Ink Cartridges Enter
4. Cyan, Magenta, Yellow or Black Enter

Ink cartridge

The front panel displays the following information for the selected ink cartridge:

Color: Cyan, Magenta, Yellow or Black.

Model: Hewlett-Packard No 82 (Cyan, Magenta and Yellow) or Hewlett-Packard No 10 (Black).
Status: inserted, low on ink, out of ink, missing, expired and faulty.

Expiration date.

Serial Number.

Ink Level: in cc and % used.
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Ink Cartridge Replacement

The animation sequence opposite shows how to
replace an Ink Cartridge.

WARNING: Make sure the printer wheels are locked
(the brake lever is pressed down) to
prevent the printer from moving.

CAUTION: Only remove an ink cartridge if you are
replacing it.

CAUTION: Do not replace cartridges while the
printer is printing because doing this will
cancel the current print job.

You would need to change cartridges either if prompted
to do so on the Front Panel because the printer has
detected a cartridge is out of ink or the cartridge is low
and you want to replace it before it runs out.

Click on the icon to run the animation

sequence.

A printable version of the sequence is also available so that you can take the key illustrations to the printer, if it is
remote from your computer.
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Printheads

* Printhead Errors
Details the different error messages that could be displayed on the front panel for the Printheads.

* Printhead Information
Shows you how to display the current status of the Printheads on the front panel display.

» Printhead Replacement
Details the Printhead Replacement procedure.

» Printhead Alignment
Details the Printhead Alignment procedure.
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Printhead Errors
The Front Panel can display the following error messages for the printheads:
Error. Selact % Errar. Select %
Replace printheads Replace printheads
- il T Il I [
= o [0 ) =
= ] )] ] =
Printhead i i
Missing Printhead
Worn Out

Errar. Select
Replace printheads Feplace printheads

Error. Select

i = G

AR & N Glilel
Perlilrjwttt):ead 4/ Un knOW”"

Error

NOTE: An unknown error is displayed when one of the printheads is causing a
problem but the system cannot detect which one it is. Refer to Unknown
Printhead Error to solve this problem.
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Printhead Information

Use the following procedure to display the Printheads Information screen on the front panel.
The front panel menu selections are:

Select (using the § keys) Then Press:
1. Ink Enter
2. Information Enter
3. Printhead Enter
4. Cyan, Magenta, Yellow or Black Enter
printhead

The front panel displays the following information for the selected printhead:
« Color: Cyan, Magenta, Yellow or Black
* Model: Hewlett-Packard No 11 and Warranty (In warranty or Out of warranty)

» Status: inserted, missing, faulty worn-out and unknown.
If there is a problem the system displays an action: missing -> insert, unknown -> troubleshoot,
faulty, worn out -> replace.

» Expiration date.
» Serial Number.
* Ink Used: in cc and % used.
e Paper Jams.
« If the printheads are aligned and color calibrated.
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Printhead Replacement

The animation sequence shows how to replace a
printhead in the printer.

The front-panel menu selections are:

Select (using the § keys) Then Press:
1. Ink Enter
2. Replace Printheads Enter
Click on the icon to run the animation

sequence. A printable version of the sequence is also
available.

Once you have replaced the printhead, if you have

media loaded, the printer prompts you to start the

Printhead Alignment procedure. If no media is loaded

the printer prompts you to load paper and then automatically starts the alignment. The alignment takes several
minutes to complete and then printer will then prompts you to run the Color Calibration procedure.
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Printhead Alignment

You should have one of the following types of paper loaded before attempting to align the printheads: HP Bright
White Inkjet Paper (Bond), HP Coated Paper, HP Heavyweight Coated Paper, HP High-Gloss Photo Paper, HP
Satin Poster Paper or Plain Paper. If you try to do this with any other type of paper loaded, the printer will prompt
you to load a different type of paper before letting you align the printheads.

From time to time you may be required to align the printheads to ensure maximum print quality. To select
Printhead Alignment manually, make sure you have the correct type of roll or sheet media loaded.

There are two types of alignment: Standard which will take about 4% minutes; and Special which takes about
11 minutes. Standard alignment is recommended for normal use and requires paper of at least Ad/Letter-size,
loaded in landscape mode. Special alignment should be used to correct pen to paper spacing variations which
would be show by variations in vertical line quality, particularly in wide plots and fast print modes. Special
alignment requires paper of at least A3/B-size, loaded in landscape mode. Two separate prints are made.

Then use the following front panel menu selections to start the alignment:

Select (using the § keys) Then Press:
Ink Enter
Align Printheads Enter
Standard (4.5 minutes) Enter

Special (11 minutes)

Once you have made this selection the printer starts the alignment process which then takes
several minutes.

The printer will also automatically use the standard alignment process to align its printheads
after Printhead Replacement. When the alignment procedure completes after a printhead
replacement, the printer prompts you to ask if you want to run the Color Calibration procedure.
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Solutions

These topics guide you through the different procedures required to troubleshoot and find the solutions to various
problems you could encounter while using your printer.

The Solutions Tab contains these topics:

Solving Problems helps you to quickly troubleshoot your specific problem; it also contains instructions on
where you can get further information.

Image Quality Problems helps you to solve any image quality problems you may be experiencing. It takes
you through the troubleshooting procedure step-by-step.

Ink Supply Problems guides you when you have problems installing the consumable ink items: the ink
cartridges and printheads.

Media Problems contains information on what to do if you have image smears or marks on your media, and
also what to do if you have a media jam.

Image Error contains information on what to do if the image that your printer printed is incorrect, or not what
you expected.

Other Problems covers miscellaneous problems you could face.

Getting Help explains what to do if you cannot solve the problem you are having. It also provides full details
of the steps to take to contact the Hewlett-Packard Customer Care Center.
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Options

Solving Problems

To find the meaning of front-panel messages, see Message Descriptions.

If you know the problem is related to a certain task, first check the relevant section in this manual, for step-by-
step procedures. Use this manual’s index or table of contents to find the section. For example, if you are hav-
ing difficulty with page formatting, refer to Page Format.

If the problem is directly related to the quality of your printed images, refer first to Image Quality Problems.
Refer to the appropriate topic:

Ink Supply Problems
Media Problems
Communication Problems

Image Error
Other Problems

If the problem could be related to your software driver, and you are using an HP driver, refer to the driver's
troubleshooting documentation and the on-line help in your application software.

If the problem has no obvious cause, refer to Finding the Source of Your Problem.
If you still cannot solve the problem, see Getting Help.
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Finding the Source of Your Problem

1. Look at the front-panel display for messages. See Message Descriptions for a full explanation of front-panel
messages.

2. Test the printer.
— Switch the printer off on the front of the printer. Make sure that the power cord is firmly inserted in the
printer and plugged in to an outlet that you know works.
— Switch the printer on and make sure the front-panel display shows the HP welcome screen followed by
Main Menu after a short initialization period.

3. Test your computer hardware and interface.
— Make sure that you have the correct interface cable between the computer and the printer and that it is
firmly connected to the correct ports (see the Assembly and Set-up Poster).
— Check that your printer’s graphics language setting (in Setup > Graphic Language) matches the
requirements of your software.
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Image Quality Problems

Your HP DesignJet 800PS printer provides a full troubleshooting utility to ensure you can always quickly
overcome any image problems you encounter. You should use this utility whenever you (and not the printer)
perceive a problem with print quality.

Often what you believe to be a print quality problem is in fact caused by incorrect configuration of the printer for the
type of image you are trying to print. Always check Configuration Correction as your first diagnostic task to find the
cause of your problem.

If a message, such as “PRINTHEADS not functional” appears on the front-panel of your printer, follow the
instructions given for the particular message (see Message Descriptions).

The types of problems you could possibly encounter are:

e Stepped Lines
e Incomplete Lines

» Color Accuracy
e Horizontal Banding
e Color Alignment

Whenever you see any of these problems work through the Troubleshooting Procedure replying to the questions
displayed on the front panel. This will lead you to correct remedial action required to solve your image quality
problem.
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Configuration Correction

Before attempting the image quality diagnostic procedures contained in this section, you should first check that
the printer is correctly configured to print what you want. Many problems concerned with image quality can be
solved by correcting the way the printer is configured.

1. To achieve the best performance from your printer, only use genuine HP accessories and supplies, whose
reliability and performance have been thoroughly tested to give trouble-free performance and best-quality
prints. For details of HP media, see Paper Types.

2. Make sure that the Type of paper selected in the front panel is the same type of paper loaded into the printer.
To check this go to the Roll or Sheet menu in the front panel and press Enter.

3. To ensure the maximum print quality use HP certified media only. For details of HP media see Physical
Characteristics of Paper Types. You can also look at the web page http://www.hp.com/go/designJet for the
most up-to-date information.

4. Make sure that the Print quality (Fast, Normal, Best) used for your printer is correct. This is set in the Print
Setup dialog box of the printer driver or in the front panel from the Set-up menu. The printer driver setting
overrides the front panel setting.

5. Select Best print mode for maximum print quality.

6. For Non-HP drivers, set front panel media settings to match the media type loaded in the printer. The
documentation that came with your software should provide information about media type/print quality
settings.

7. If your image quality problem is color accuracy related, go to Color Accuracy for further
configuration help.
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Troubleshooting Procedure

Working through the Troubleshooting procedure should always be your first action when you encounter image
quality problems. Refer to the Troubleshooting Flow Chart for a description of the sequence of processes used to
complete troubleshooting procedure.

It is important that the paper loaded for this procedure is exactly that used when you encountered image quality
problems, type (for example, glossy paper) and size. If you use a different kind of paper or a different size, you
stand less likelihood of resolving the problem.

Running the Troubleshooting Utility

1. From the main front-panel menu, select the Ink menu (.:};:,) and press Enter.

2. Select Troubleshooting and press Enter.
Ink mero

3. The printer first checks to see whether the Informnation

printheads are aligned. Misalignment of the i

. . : . a
printheads is a common cause of image quality Align printheads

problems. If they are not aligned, you are prompted Replace printheads

to accept Printhead Alignment. This procedure

requires a few centimeters of paper loaded and takes several minutes to perform.

]
4
k
]
]

NOTE: Note that you do not have to interpret the patterns printed by the Printhead Alignment routine.

4. If the printheads do not seem to require alignment, the printer prints Diagnostic Print A. See Diagnostic Print

A Interpretation for full details of how to use this diagnostic print.
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Diagnostic Print A Interpretation Diagnostic Print A

Diagnostic Print A contains several blocks of color and a block of thin black
broken lines (the lines are actually very much closer than those represented
here).

1. Examine the broken lines in Diagnostic Print A carefully and indicate whether
there are problems with them. The sorts of problems to look for here are:

« Jaggedness or serrations in the thin lines, like this:
o~ e~~~ the thin lines should be straight,
though not necessarily perfectly aligned. The irregularities that are significant

extend along the whole of the length of the lines. Shorter irregularities, Ignore this
arranged in columns, can be ignored at this stage. black bar —¥
2. Examine the blocks of color in Diagnostic Print A carefully and indicate whether _
there are problems with them. The sorts of problems to look for here are:

*  White streaks or bands in the solid blocks. —

3. If you indicate that there is a problem with the dashed lines in Diagnostic Print A,
you are prompted to use the Advance Calibration routine; your printer will be at step 3 of the routine (if you don’t
want to continue with calibration, press the Cancel key).

4. If there are problems in the blocks of color in Diagnostic Print A, for example white streaks or bands, the printer will
try to clean the printheads that have the problem. A printhead can be cleaned up to three times this way; after that
it cannot be cleaned and you will be told; the Troubleshooting routine will finish. In that case we recommend that

you try to reprint your print, and then, if necessary, start the Troubleshooting routine again.
After cleaning the printheads, the printer reprints the blocks of color (but not the black lines) in
Diagnostic Print A, and asks you to examine it again (as in step 1).

5. Ifthere are no problems the first time you print Diagnostic Print A, the printer prints Diagnostic
Print B. See Diagnostic Print B Interpretation for full details of how to use this diagnostic print.
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Diagnostic Print B Interpretation
1. For each color in the pattern in Diagnostic Print B, you are asked about the Diagnostic Print B

quality—Ilook for missing lines. If you answer that a color is defective, the

printer tries to clean that printhead.

If the printhead cleaning process completes, Diagnostic Print B is printed I ‘ ‘ ‘ ‘ ‘ ‘
again and you are asked the same questions again.

2. Afterwards, if problems with images remain, use the Troubleshooting Ignore these
procedure again. solid bars I ‘ ‘ ‘ ‘ ‘ ‘

If none of the patterns or blocks in the two Diagnhostic Prints shows any problem, it could be that your image
quality problem is caused by a wrong setting in your software, or perhaps the job should have been printed with
the Print quality set to Best instead of Normal or Draft.

If the Troubleshooting routine didn’t indicate that printhead alignment was necessary, you can select Align
printheads in the Ink menu to try to solve any further image quality problems.
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Troubleshooting Flow Chart
The following diagram shows the flow of the troubleshooting procedure.

Indicates that

troubleshooting has
completed but further
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Advance Calibration

It is important that the paper loaded for this calibration is exactly that used for normal printing, both in quality (for
example, glossy paper) and in width (for example, AO or 36-inch). Either roll or sheet paper can be used.

The routine prints a pattern and then cuts the roll (the cutter must be set to On—see Controlling the Cutter) or
ejects the sheet; it requires paper that is at least 65 cm/25.5 inches long and at least 50 cm/19.7 inches wide. You
must then reload that piece of paper as a sheet, so that the printer can accurately measure the pattern, and make
whatever adjustments are appropriate to the amount it advances between printing swaths of data. (See Loading
Sheet Media)

The pattern printed is solely for the use of the printer; you are not expected to relate any of its characteristics to the
quality of your images.

1.

2.
3.

From the main front-panel menu, with the correct paper loaded, select the Paper menu (@) and press Enter.

Select Advance calibration and press Enter.

Select Create pattern and press Enter.
The printer prints its calibration pattern (as represented
here) and cuts or ejects the paper.

Load the sheet printed side up with the dotted line at the
top (that is, rotated 90°).

Now select Measure pattern and press Enter.
The printer reads the calibration pattern and makes the
appropriate internal adjustments.

Direction of paper while
printing (creating pattern)

<D

These Advance Calibration Values are used
whenever you print on the same type of media until
you have used the Advance calibration twice more Direction of paper when

with different types of media. ~&—|pading (measuring pattern)
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Advance Calibration Values

The printer stores the advance calibration values of the last two
different types of media used for the calibration. When you print the
printer ties to match the media you have selected to the stored
values. If there is a match the printer applies the stored Advance
calibration values.

Aduance calibration

p
Restore factory

If the type of media you are using has not been used for either of the
last two Advance calibrations the printer uses a set default values for
your media.

The Restore factory option of the Advance calibration menu erases any stored advance calibration values from
the printer memory. This means that until you run the advance calibration again the printer will use the factory
default values for all types of media.



Printer

Introduction Media & Ink Front Panel Options Other Index

Stepped Lines

When you look at the image you have printed there are ‘stepped lines’ in the borders of arrows and diagonal
lines. The lines should be straight with no stepping.

The following is an example of what you might see if you have problems with stepped lines.

To solve this problem:
1. Increase the dpi setting by changing the print quality to Best in the front panel and driver software.

2. The problems may be inherent in the image you are trying to print. Try to improve the image with the
application that generated the file.
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Incomplete Lines

When you look at the image you have printed there are:

* Missing or faint lines.

» Printed characters having missing parts to them.

The following is an example of what you might see if you have problems with incomplete lines.

| ESI
/

Missing parts of text; this
should say TEST

See the Troubleshooting Procedure for instructions on how to solve this problem.




Printer

Introduction Media & Ink Front Panel Options

Other Index

Color Alignment

When you look at the image you have printed:

N\ ( |
The colored lines are printed ‘

double and they are the wrong
colors ‘

\\\\ |

Vertical lines are misaligned or
fuzzy (not smooth)

The borders of colored blocks
are overlapped and the
overlapping areas have
different colors in them.

See the Troubleshooting Procedure for instructions on how to solve this problem.
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Horizontal Banding
When you look at the image you have printed there are light or dark lines on the image, these are particularly
highlighted in high density ink areas. This problem is known as banding.

IMPORTANT Banding can occur to a certain degree in Fast and Normal mode when printing high
density prints. To obtain the best image always print in Best Mode.

The following is an example of what you might see if you have problems with banding.

—
—— - g/

NG T i oy |
| \oqesr ISl W

|\ o W |
|\ 2 = v | O ”"k

See the Troubleshooting Procedure for instructions on how to solve this problem.
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Color Accuracy
These are the areas you should review when troubleshooting a color accuracy problem:

Configuration

Check that you are using the correct driver setting for your software. Check which ink emulation mode has been
selected in the front panel; see Color Settings.

Media

Ensure the media loaded is genuine HP media and the correct media type selected on the front panel and in the
driver.

Related Topics

» Color Consistency problems

« Long Term Color Bleeding (Glossy Papers)

e Color Accuracy Configuration

» Additional Color Accuracy Information
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Color Consistency problems
* Some media may discolor or change with age. Check that your media is fresh and has been stored correctly.

« If the environmental conditions you are printing in change rapidly, you may see changes in the color consis-
tency. By reducing the time the print stays in extreme environmental conditions after being printed (especially
very high humidity) you can reduce the color consistency problems.

* There may be color changes between images printed on your HP DesignJet 800PS and other types HP
DesignJet printers. This is quite normal because the other printers use different ink.
Long Term Color Bleeding (Glossy Papers)

High ambient humidity at your location could cause the colors to bleed into the paper making the lines fuzzy and
bleary.

» Change the paper that you are printing with or remove the printer from the high humidity conditions.
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Color Accuracy Configuration

The configurations of the printer defines how ink is applied to each type of media. Use the information in the
following table to configure your printer and software for best color accuracy.

Location of Setting Description Selection

Setting

Ink Menu Color Calibration > Calibrate Set to match the media type loaded in the
Paper printer. See Paper Types.

Ink Menu Color settings > CMYK Set the type of CMYK inks that your software

generates. If you use HP drivers use “Native”.
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Additional Color Accuracy Information

The means of accurately managing the colors printed by your printer vary with the software application and driver
being used. Refer to the following documentation:

* On-line documentation in the drivers shipped with your printer.

* If you cannot find any reason for the discrepancy, before getting help, find out for which CMYK printer inks the
colors have been specified.
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Ink Supply Problems

Most of the problems that you could encounter when working with HP Ink Supplies are solved with guidance from
the front panel. The only exception to this is the Unknown Printhead Error. A full list of front messages are
supplied in Message Descriptions.

Printhead Problems after Replacement

If, after replacing the printheads, the printer complains about wrong or missing printheads, perform the following
steps:

» Check that you have removed the protective tape from the printhead.

» Insert the printhead into the carriage assembly, but this time close the cover using the latch.

* Replace the printhead with a new one, see Printhead Replacement.

Problems Inserting the Ink Cartridge
1. Make sure that you have the correct HP Ink Supplies ink cartridge.
2. Make sure that the cartridge is the correct color for that slot.
3. Make sure the cartridge is in the correct orientation, with the color coded label at the top.
CAUTION: Never clean inside the ink cartridge slots.
Problems Inserting the Printhead
1. Make sure that you have the correct HP Ink Supplies printhead.
2. Make sure that the printhead is the correct color for that slot.

3. Make sure that the printhead is the correct orientation.
See Printhead Replacement for further details.
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Unknown Printhead Error

An unknown printhead error occurs when the one of the printheads is causing a
problem but the system cannot detect which one it is. Whenever this happens the

Printheads not aligned.

front panel displays this error message. The number of printheads with unknown Paper tupe not walid
errors will either be all the color printheads or all the printheads. to align printheads.
Use the following procedure to isolate the faulty printhead. Smmme (ST b SeriE e

1. Select Replace Printheads from the front panel.

2. Open the carriage cover and remove ALL the printheads.

3. Reinsert the Cyan printhead only and close the carriage cover and the window.
4

Check the front panel—if the status of the Cyan printhead is X or ?, the conclusion is that the Cyan printhead
is faulty and must be replaced. If the status of the Cyan printhead is OK, the conclusion is that the Cyan
printhead is working correctly. Repeat the process from step 1 for the other color printheads to identify which
one is failing.
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Media Problems

* Media
Details the general rules to follow to avoid media problems.

» Clearing a Media Jam
Describes how to clear a media jam.

* Ink Marks on the Media
Details the way to solve ink mark problems: warped lines, blurred lines, marks or scratches on glossy paper.

» Media Loading Problems
Explains what to do when the front panel keeps indicating that media is misaligned or incorrectly positioned.

* Media Output Problems
Explains what to do when the prints fall on the floor or do not stack correctly in the media bin.
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Media

Always make sure that you are using the appropriate media for your image and that it is consistent with your
software application. To ensure color accuracy and print-quality performance of the printer, use only media types
that have been certified for your printer.

Use of non-HP media or HP media not certified for your printer may significantly reduce the color and print quality
of your images. For details of HP media, see Paper Types.
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Clearing a Media Jam

If the front panel displays this message:
[Fossibly & paper jam

There is probably paper jammed in the printer. Paper jams can have 1. Open window

various causes: 2. Buwitch power of f

« The paper is too thick or too thin for the printer, or is otherwise not 3. Llear paper path
ted 4. Switch power on
supportea. 2. Aligh printheads

» The paper is creased or misaligned or is bubbled.

» Too much ink is being placed on the paper causing it to cockle or bubble.

* The end of the roll of paper is glued to the core and won’t advance further.

» Pieces of paper or paper powder are clogging up the cutter guide or other moving parts.

See Removing Jammed Paper for full instructions on how to clear jammed paper.
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Removing Jammed Paper
1. Open the window.
2. Switch the printer off at the front.

3. If necessary, carefully move the printhead carriage out of the way—if possible all the way to the enclosed area
on the left or the right. Which way you are able to move it depends on where the paper is jammed.

CAUTION: When moving the printhead carriage, touch only the black plastic parts.

4. If necessary, carefully move the paper cutter out of the way to the left,
or to the right depending on where the paper is jammed (though if Slider bar
moved right it may block the paper path).

CAUTION: The cutter is easily moved by holding it as close as
possible to the guide running across the width of the
printer. Be careful not to touch the metal slider bar that
runs across the printer.

Guide

5. If necessary, lift the blue paper lever, to release any trapped paper.
Remember to lower it again when you have finished.

6. Carefully remove any of the jammed paper which you can easily lift up and out from the top of the printer.

7. Carefully pull the rest of the roll or sheet down and out of the printer. You may need to cut the edge of the roll
with scissors.

8. Check that the printing zone, including the cutter guide, the paper path, and the area
where the printhead carriage is parked, is clear and clean; remove any paper powder by
brushing it away or with a vacuum cleaner.

More ...
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Removing Jammed Paper (continued)

CAUTION: The areawhere the printhead carriage is parked can get quite dirty; be careful not to get ink on
your hands.

9. Close the window and switch on the printer.
10. Wait for the printer to finish initializing.

11. Press the Form Feed and Cut key on the front panel to eject any small pieces of paper that are still in the
paper path.

12. Reload the paper as normal (see Loading Roll Media or Loading Sheet Media). If you are using roll paper you
may need to trim the edge first, to ensure that it is straight.

NOTE: If there is still paper left in the paper path, try loading a sheet of stiff or rigid paper into the
printer, such as heavy coated or matte film; this will help to force out any paper jammed in the
paper path.

13. If the cutter seems to be causing the problem, check in Paper Types that the type of paper is supported by the
printer. Try disabling the cutter from the front panel; use @ — Cutter — Off.

You are strongly recommended to align the printheads (see Printhead Alignment) after clearing a paper jam, as
the problem may have caused the printheads to be misaligned.

Back ...
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Ink Marks on the Media

» Warped Lines
e Blurred Lines (Ink “Bleeds” from Lines)

e Marks or Scratches on Glossy Paper after Printing

 Smears or Scratching on Your Printed Media
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Warped Lines

* The media itself may be warped. This can happen if it has been used or not been stored in the correct environ-
mental conditions.

» For all environmental specifications, see Enviromental Specifications.
Blurred Lines (Ink “Bleeds” from Lines)

* Perhaps you have adjusted the drying time in the front-panel menu to speed up the printer output. Set “Drying
time” to “Automatic”.

For details of drying time adjustments, see Ink System.

Marks or Scratches on Glossy Paper after Printing

Glossy paper may be extremely sensitive to the bin or anything that it comes into contact with directly after
printing. This will depend on the amount of ink printed and the environmental conditions that are present at the
time of printing. Avoid any contact with the paper and handle the print with care until quite some time has elapsed.

NOTE: Included with HP media is a book “Printer Tips” that includes a section on troubleshooting
paper problems.
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Smears or Scratching on Your Printed Media

This problem can appear on paper-based coated media if a lot of ink is printed quickly. The media cannot absorb
the ink quickly enough and becomes distorted. As the printheads move over the media, the printheads and the
media come into contact with each other and the printed image is smeared.

1. Press the Cancel key on the front panel; if you continue to print, the paper may damage the printheads.
2. Cancel the print job from your computer application.
3. In order to obtain better results perform the following:
» Use HP recommended media. If the image you are printing has intense color, use HP Heavy Coated Paper.

» Try to increase the print margins by relocating the image in the page from your software applications.

» If you are using ‘Media Saving Options’ from the advanced section of the HP- GL/2 driver, try disabling one
or both the options ‘Autorotate’ and ‘Inked Area’.

If the above fails to solve the problem of smears and scratching, change the media you are using to a non-paper
based media such as HP Clear film.
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Media Loading Problems

The front panel keeps indicating that media is misaligned or incorrectly positioned.

Roll media

» The roll media may be loaded the wrong way. The paper should load over the roll towards you, see Loading
Roll Media.

* The paper may be skewed. The right-hand edge must be parallel to the blue line on the front media deflector.
» Ensure that the paper is wrapped tightly on the roll.
» Check that the paper is correctly loaded onto the spindle, see Installing a New Roll on the Printer.

Sheet media

» The sheet media must be loaded with the right-hand edge against the blue line on the printer platen and the
front edge against the blue line just after the pinch rollers, see Loading Sheet Media.

* The media may be crumpled or warped or may have irregular edges.

» If you are using hand-cut media, the edges may not form a right-angle or they may be rough. Do not use hand-
cut media. Use only purchased sheet media.

» If the media is curled with the curl up it will be very difficult to load. It is easier to load it with the curl down
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Media Output Problems

Prints Fall on the Floor After Being Cut

» Make sure the media bin is open.

* Do not let more than twenty prints accumulate in the bin.

» Make sure roll media is loaded correctly. If the paper is loaded incorrectly, the natural curl of the media may
cause it to miss the bin and fall to the floor.

Prints Do Not Stack Properly in the Media Bin

* The printer may be too close to the end of the roll. The natural curl near the end of the roll can cause stacking
problems. Load a new roll or remove prints manually as they are completed.

» If you are mixing prints or nesting sets of several different sizes, you may have stacking problems because of
the different sizes of media in the bin.
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Image Error

Image is Incomplete
Details the actions to take when the print is: Blank, Partial or has suffered clipping.

Printed Image Incorrect

Explains why the image is:

In one portion of the printing area.

Unexpectedly rotated.

Mirrored.

Distorted or unintelligible.

Overlaid with another image.

Does not obey Page Format and Rotate commands.

Other Sources of Information

Lists others sources of information for image problems.

Index
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Long-Axis Print Is Clipped
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Print is Completely Blank

If the front-panel Graphics language setting is Automatic (the default), try the other settings: (PostScript for a
PostScript file, HP-GL/2 for an HP-GL/2 file, etc., and send the file again.

Output Contains Only a Partial Print

» Did you press Cancel or Form Feed and Cut before all the data was received by the printer?
If so, you have ended the data transmission and will have to print the page again (you normally don’t need to
press Form Feed and Cut to unload the print).

* The I/O Setup > I/0O Timeout setting may be too short. From the front-panel menu you can increase the
I/O Timeout setting to a longer period and then send the print again.

* There may be a communications problem between your computer and the printer.
Check your interface cable.

» Check to make sure that your software settings are correct for your current page size (for example, long-axis
prints).
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Image is Clipped

» This normally indicates a discrepancy between the actual printing area on the loaded media and the printing
area as understood by your software. For general advice on printing areas and page size, see Printable Area.

» Check the actual printing area for the media size you have loaded (printing area = media size — margins). For
media size and margins, see Printable Area.

* Check what your software understands to be the printing area (which it may call “printable area” or “imagable
area”). For example, some software applications assume standard printing areas that are larger than those
used in this printer.

» Check that the orientation of the media is the same as that assumed by your software. The front-panel Paper
> Page format > Rotate option changes the orientation of a print and, on roll media, the orientation of the
page. It is possible that a rotated image on roll media may be slightly clipped in order to retain the correct page
size, as explained in Page Size.

* You may have asked to rotate the page from portrait to landscape on media that is not wide enough, for exam-
ple a D/Al-size page rotated on a D/Al-size roll.

» If necessary, change the printing area in your software.
* The file may be too large for the printer's memory.

Long-Axis Print Is Clipped

» Does your software support long-axis prints?

» Have you specified an appropriate media size in your software?
* Make sure that the printer's Page format > Size is set to Inked area.
« There may not be sufficient memory.
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Printed Image Incorrect

Image is in One Portion of the Printing Area

Image is Unexpectedly Rotated

Print is a Mirror Image of the Original

Print is Distorted or Unintelligible

One Image Overlays Another on the Same Sheet

Pen Settings Seem to have No Effect

Page Format or Rotate does not Work

Printer
Options

Other

Index
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Image is in One Portion of the Printing Area

» Is the page size configured in the software too small?

» Are you sure that your software doesn’t believe the image to be in one quadrant of the page?
* Otherwise, this indicates an incompatibility between the software and the printer:

» Is your software configured for this printer? For general advice, see the Assmebly and Set-up Poster. For
advice specific to your software, see the documentation supplied with the driver.

» If you still haven’t found the solution, try changing the printer’s Graphics Language setting on the front panel
(Setup > Graphic Language).

Image is Unexpectedly Rotated

» Check the front-panel Paper > Page format > Rotate setting.

» If Queueing and Nesting are both ON, pages may be automatically rotated to save media. See Rotating an
Image

Print is a Mirror Image of the Original
» Check the front-panel Paper > Page format > Mirror setting.
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Print is Distorted or Unintelligible

» The interface cable between your computer and the printer could be faulty. Try another cable to see if the
problem is corrected.

» If you have connected your computer to the parallel port on the printer, make sure you are using a genuine HP
parallel interface cable.

» Depending on the software, drivers and RIPs you are using with your printer, there will be different solutions to
solving this problem. Refer to the Vendor’'s User Documentation for details.

One Image Overlays Another on the Same Sheet

* The l/O Setup / I/O Timeout setting may be too long. From the front-panel menu decrease the setting and print
again.

Pen Settings Seem to have No Effect

» Either: you have changed them in Pen settings / Define palette but forgotten to select that palette in Pen set-
tings / Palette,

» Or: you expected the software-driven pen settings but in the front-panel Pen settings / Palette is not set to
Software.

» Or: you changed the setting in the front panel but this has been ignored by the printer because the driver set-
ting has not been changed.
Page Format or Rotate does not Work

» The printer cannot rotate raster images. If your file contains raster data (typically, images with heavy area fill
and shading that you have scanned into your software) you will not be able to rotate the
print.

* Your driver does not allow this to happen.
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Other Sources of Information

If you don't find the solution to the problem here, other sources of help are:

* The documentation supplied with the driver that you are using to manage the output from your software appli-
cation to the printer.
For example, the on-line and printed documentation included in the following drivers supplied with your
printer:

HP DesignJet PostScript® drivers for Power Macintosh® and Macintosh® (QuickDraw ™)

HP DesignJet PostScript® drivers for Microsoft® Windows™ applications.

AutoCAD™ windows drivers
Windows drivers
* The HP-GL/2 driver documentation supplied with your application software.
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Other Problems

e Communication Problems

Describes typical problems you could encounter with communications between your computer and the
printer.

» Printer Does not Print
Details common causes for the printer failing to print.

* Printer Seems Too Slow
Lists the reasons why printing may slow down.

» Printer Waits Too Long to Print a Nest
Explains the cause for the printer waiting too long to print a nest.
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Communication Problems

Symptoms are:

The front-panel display does not show Processing when you are sending a print to the printer.
Your computer displays an error message when you are trying to print.

Your computer or printer “hangs” (stays idle) while communication is taking place. However, note that large
prints can take a correspondingly long time to print.

Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

How to solve the problem:

Have you selected the correct printer in your software?
Does the printer work correctly when printing from other software?

If the printer is connected to a network, try using it when connected directly to your computer through parallel
or USB ports.

If your printer is connected to your computer through any other intermediate devices, such as switch boxes,
buffer boxes, cable adapters, cable converters, etc., try using it when connected directly to your computer.

Try another interface cable. For details of supported cables, see Connection Specifications.
Make sure the graphic language setting is set to the correct setting; see Changing the Graphics Language.

File Size and Memory

There is no direct relationship between file size on your computer and memory used in the
printer to print that file. In fact, because of file compression (and general complexity) it is often
impossible to estimate how much memory will be used. This means that some large prints will
work fine, but some smaller prints may not and you will have to add more memory to your
printer.
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Printer Does not Print

You may have a power problem. If there is no activity at all from the printer, and power on indicator in the
power switch on the front of the printer is off, check that the power cable is connected correctly and that there
is power available at the socket.

If you are using a Macintosh and the print job does not print, ensure the printer language is set to Postscript or
Automatic. See Changing the Graphics Language.

You may have a problem with your application driver. Is your software configured for this printer? For general
advice, see the Assembly and Set-up Poster. For advice specific to your software, see the documentation sup-
plied with the driver.
If you have connected your computer to the printer’s parallel port or USB port and tried to print a binary-
encoded PostScript file it will not print. The parallel and USB ports will only accept ASCll-encoded PostScript
print files. The front panel will display the message “Error processing job / Flushing rest of job”.
You will need to setup your application to encode the file in ASCII instead of binary and then send the job
again through the parallel or USB port.
You could also connect your computer via the LAN connection of your printer and send the binary encoded
PostScript print file again.
The file may be too large for the printer's memory. This is the case if the front panel displays “Out of memory—
data was lost”. Look on your computer screen for any error message; some drivers allow you to choose a dif-
ferent printing mode and try to send the file again.

If you continue to have problems, see Getting Help.
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Printer Seems Too Slow

» Did you specify Best print quality level on the front panel?
Best quality mode prints take longer to print.

» Did you specify the right media type when loading the media? For details of front-panel media types, see
Paper Types. To find out the printer’'s current media type setting, see Obtaining Roll or Sheet Paper Informa-
tion.

* The printhead may need replacing; see Printhead Replacement

» Did you specify a Manual Dry Time in the front panel? Change the dry time to Automatic see Ink System.

« Ifthe printeris in Fast mode and the file it is printing contains high density inked areas, the printer may need to
slow down to compensate.

Printer Waits Too Long to Print a Nest

Change the Nest wait setting. See How Long does the Printer Wait for Another File?
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Getting Help
» HP Customer Care
Details about the HP Customer Care program.

* What to Do Before You Call
Information on what you should do before you contact your local HP Customer Care Center.

» HP DesignJet Online
How to get help and much more via the World Wide Web.
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HP Customer Care

As your strategic support partner, we make it our business to help keep your business running smoothly. HP
Customer Care offers award-winning support to ensure you get the most from your HP DesignJet.

The contact details for your local HP Customer Care Center are provided in the Hewlett-Packard Customer Care
booklet supplied with your printer.

HP Customer Care provides comprehensive, proven support expertise and leverages new technologies to give
customers unique end-to-end support. Services include setup and installation, troubleshooting tools, warranty
upgrades, repair and exchange services, phone and Web support, software updates, and self-maintenance
services.

To find out more about HP Customer Care, please visit us at: www.hp.com/go/support.
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What to Do Before You Call

1. Review the troubleshooting suggestions in this section:
— In the relevant driver documentation supplied with this printer (for users sending PostScript files or those
using Microsoft Windows).
— If you have installed third party software drivers and RIPs refer to that user documentation.

2. If the problem appears to be related to your software application, first contact your software vendor.

3. If you still have difficulty, refer to the HP Support Services booklet shipped with this printer. This document
contains a comprehensive list of various support services available to help solve printer problems.

4. If you do call one of the Hewlett-Packard offices, please have the following information available to help us

answer your questions more quickly:

— The printer you are using (the product number and the serial number, found on the label at the back of the
printer).

— The computer you are using.

— Any special equipment or software you are using (for example, spoolers, networks, switch-boxes, modems,
or special software drivers).

— The cable you are using (by part number) and where you purchased it.

— The type of interface used on your printer (parallel, or network).

— The software nhame and version you are currently using.

— If the problem is a system error it will have a error number; record the error number and have it ready. See

Printer Does not Print.
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HP DesignJet Online

Direct access to HP and the information you want, when you need it. Register now!

www.hp.com/go/designjet

HP DesignJet Online is a free, web-based “user club” exclusive to HP DesignJet users. Having registered, the
user has unrestricted access to a range of useful services, the emphasis being on “useful”, as this is definitely not
a sales-oriented site.

Communication from HP to users includes:

a quarterly newsletter focussing on usage tips, technical briefings and examples of HP DesignJet applications
around the world;

full information on worldwide HP Customer Care contacts;

an on-line HP DesignJet Diagnosis troubleshooting tool;

a calendar of HP DesignJet-related events and programs;
on-line access to training videos and selected user documents;
and immediate information on new products.

Communication from the users to HP includes:

feedback on HP DesignJet features;
automatic contact with HP Customer Care from the troubleshooting tool, for HP to follow up;
and the chance to ask technical questions on large-format printing to industry experts.

And finally, communication from user to user includes the chance to win prizes by submitting
HP DesignJet success stories, as well as a user-to-user discussion forum where users can
share best practices and ask for advice from their fellow professionals.

HP DesignJet Online is available in English, German, French, Italian, Spanish and
Portuguese.


http://www.hp.com/go/designJet
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Front Panel

The printer's front panel is a user-friendly interface that gives you access to a comprehensive set of printer
functions. There is also information on your ink consumable items which is continually updated.

e The Front Panel

 Menu Structure

+ Navigating the Menu System

* Message Descriptions
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The Front Panel

The panel on the front of your printer is the principal way of changing the behavior of the printer, apart from any
software driven controls that may be provided through the application in use. The front panel of the printer
contains the following functional areas:

Job management manu

Readuw 'ﬁ]

Display Screen Navigation Keys Action Keys



Printer

Options Other Index

Introduction Media & Ink Solutions

Navigation Keys

The display section of the front panel consists of an LCD display and the following five navigation keys, provided to
navigate through the menus displayed on the screen:

+ The Up 4 and W Down keys let you scroll through the various items in a menu list.

* The Menu key takes you to the main screen. It cancels any choices that have not yet been selected by press-
ing the Enter key.
» The Back key takes you to the previous screen.

» The Enter key selects the item in the menu list and makes it current. If there are sub-selections to be made,
this key takes you to them; otherwise it takes you back a screen.

Back Menu

Up
Job management manu % \ \

Feady 'ﬁ]

Down Enter
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Display Screen

The display screen of the front panel shows the main menu (the words displayed may vary).

NOTE: You can always reach the main menu by pressing the Menu key.

After a short time-out, the display will always revert to the main menu with the Job Management menu active.

Active menu \

Job management manu % -a—— Paper Menu Icon
lﬂ'}j -a—— Ink Menu Icon
-«—— Job Management Menu Icon (Active)

Information ¥ [Ready i <= Setup Menu Icon

message

The Navigation Example is given from the Job Management menu.

Error
Message \ %
Error. Selact
Replace printheads
a1 [ [ =
HAR 2

/DI
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Action Keys

The Cancel key cancels the current printer operation (printing or preparing for printing). It will also cancel the
current menu selection and return to the main menu if a menu option is highlighted.

The Form Feed and Cut key causes a sheet to be ejected or the roll to be advanced and cut.

Cancel

Job management manu

& el

Readw

Al

Form Feed
and Cut Key
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Menu Structure

The front panel display area screen shows the four classes of menu options available represented with specific
icons. Click on the icon to displays its menu structure.

Paper Menu

Ink Menu

Job Management Menu

) B [&] &

Set-up Menu
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Paper Menu

Click on a menu item to go to the relevant topic.

Load/Unload Roll
IPEART Load/Unload Sheet

Printer
Options

Other

Index

—| Select paper type
—] Cutter —— on/oFF |

—| Page Format |——| Size |——| Automatic

Inked area

— ANSI

|—| BestANSIA...E

1s0

|—| BestISO ...A0

—ais

—{Bestais ..B1

—| ARCH

—{BestARCH ..E1

—| Oversize

|—| Over A2, Over Al

—| Extra

|—| 100cm x 140cm, ..

— Rotate —0. 90,180,270

—| Mirroring

|_| on/off

—| Advance Calibration Create pattern |

Measure pattern
Restore factory

[l

Menu item depends on the
type of media loaded

I Bright White Inkjet Paper |

—| Plain Paper

—| Vellum

—| Natural Tracing Paper

—| Translucent Bond

{ Clear film

—| Matte film

—| Coated Paper

—| Heavy Coated Paper

—I High-Gloss Photo

—| Poster Paper

—I Canvas

I:' Only shown if mediais loaded I:' Items always shown
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Click on a menu item to go to the relevant topic.
Ink
—| Information Ink Cartridges Ilnk Levels |
Printheads Cyan Printhead | Cyan Ink Cartridge |
—| Color calibration Status | Magenta Printhead | Magenta Ink Cartridge |
—| Troubleshooting | Calibrate Paper | Yellow Printhead | Yellow Ink Cartridge |
Reset | Black Printhead | Black Ink Cartridge |
—] Align Print Heads
—| Replace Print Heads |
—| Replace Ink Cartridges |
—| Color settings Color/monochrome ICoIor |
Native | Grayscale |
SRGB | True Black |
{ Native/Device CMYK |
Rendering Intent Perceptual | | Swop |
Saturation | | Euroscale |
Colorimetric | | TOYO |
—| Drying time Automatic | DIC |
None |
Manual |—|1,2 .., 99 min.

Index
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Job Management Menu
Click on a menu item to go to the relevant topic.

Job
Management

Printer

Options Other

Queue/Copies # Jobname (# Copies)

/ Queue is empty

Nest settings Nest
Wait time

——on/oFF |
L

1,2, ...,99 min. |

Menu items depend on the state of the job queue or on the
state of the currently selected job

Index
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Set-up Menu
Click on a menu item to go to the relevant topic.
—| Help
_| Print quality IBest |

Normal

—| Advanced Options Optimize for Line drawings / text

Model number, Serial number, Service ID,
Firmware rev, Accessory rev, Paper used,
Ink used (c, m, y, k), Scan axis usage,
Default | Paper axis usage, Service station usage,

| Spittoon usage, Pinch-lift usage, Cutter

|
Images |
|
|

Best Quality Settings Default
Maximum detail
]
I

Fast Quality Settings

A d —= [

Reduced speed usage, Ink usage.
—| Printer Information View
Print
_| Graphic Language !Automatic |
_| PS settings PS Scaling |—| 100% - 419%, Fitto page | Postscript |
Encoding Automatic HPGL/2 |
CALS/G4 |
—| HPGL/2 settings Palette |—| Software, Factory, Palette A, B|
Define Palette |—| Palette A, Palette B |—| Penno.0... 15 |—| Width |—| 0.13... 12.0mm|
L{ Factory —[Penno.0...15]| \—{Width 0.13...12.0mm|
Y

More menu options Merge — on/off |




Printer

1000m - 2000m

—| Log |——| Printheads
—| Errors
R - Voo [ Senvcetesis

8 servie cabaions| .

| Hidden items that can only be accessed

Service utilities I:' Items always shown . from the Set-up menu through a
certain combination of keys

>2000m |

Introduction Media & Ink Solutions Options Other Index
Set-up Menu (continued)
Click on a menu item to go to the relevant topic.

Previous menu options

A
—| 1/0 setup Card ID |—| No I/O Cards present/ Contents provided by card

: Card setup No I/O Cards present |

|

I Advanced |—| Reset Card

|

| 1/0 Timeout |—| 30sec, ..., 30 min |

|

I —| Front Panel |——| Language | English, German, Spanish, French, Italian,

| Japenese, Portuguese, Korean, Chinese,

| —| Buzzer |—| ON/OFF | Taiwanese, ...

|

I —| Contrast |—| 0%, 5%, ..., 100% |

: — Altitude | 0-1000m

|

|

|

|




Printer

Options Other Index

Introduction Media & Ink Solutions

Navigating the Menu System

From the top level of the menu system, you can navigate through the menus using the display keys. Any menu
item followed by a greater-than symbol (>), indicates that a further level of menu items is available.

Press Back to return to the previous menu ress Menu to return to the top level

level without changing any menu selections. without changing any menu selections.
This will bring you to the four menu icons.

Job mana

R
Press the Up 4 and Down W keys to scroll Press Enter to:
up and down though the menus or menu * Select a menu and move to the next menu level.
options. * Change the value of the selected menu item.

See Navigation Example for a brief overview of the menu system.
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Navigation Example
This section provides a typical example of how to navigate through the menus to configure a specific print option.
How to Set the Ink-drying Time to Two Minutes

The Front Panel Menu Structure diagram for the Ink Menu shows that the path to the Drying time option is:
Ink menu {4 — Drying time

Use the following procedure to set the ink-drying time to two minutes.
Setting Drying Time Navigation Example

Key Action Display Result

The Ink menu icon is
highlighted to allow you to
select the Ink menu options.

1. UsetheUp 4 and Ik menu
Down W keys to high- Ink lewvel=s

T el

2. Pressthe Enter key to |2 = The display shows the Ink
enter the printer Ink i menu to allow you to select

Information 3
menu. Color calibration 3
Troubleshooting ]
3
k

Drying Time.

Align printheads
Replace printheads

Continued ...
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Setting Drying Time Navigation Example (continued)

Key Action Display Result
3. Usethe Up 4 and Ink metiu 'I_'he disp_lay s_hovys the Drying
Down W keys to align printheads y|- |time option highlighted.
S . Replace printheads #
highlight the Drying Replace ink cartridgs. b
time menu option. Color =ettings b
C-ving Lime = 1 min 3
4. Press the Enter key to Drying ime The display shows the Drying
enter the Drying time time menu to allow you to
menu. select the type of drying time
Automatic you require.
Mok
Marnoal = 1 min k
5. Usethe Up 4 and Drying time The display shows the
Manual option highlighted.
Down W keys to
highlight the Manual Automatic
menu option. Hone
Manuwal=imin M

Previous ...

Continued ...

Index
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Setting Drying Time Navigation Example (continued)
Key Action Display Result
6. Pressthe Enter key to Marual The display shows the
enter the Manual drying Manual drying time setting
time setting menu. menu to allow you to select
the drying time you require.
1 mir T
7. Pressthe Up 4 key Maral The display shows the
once to select two Manual d_rymg time s_ettmg
minutes. menu with two minutes
selected.
[2 min 13
8. Pressthe I_Ente_r key to Marual If the front-pan_el Buzzer is set
set the drying time to two ON, there will be a short
minutes. ‘beep’ to confirm the change
A tick mark () in the right side
_ of the field confirms the value.
[2 min Jt:
Previous ... Continued ...

Index
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Setting Drying Time Navigation Example (continued)

Printer
Options

Other

Index

Key Action

Display

Result

9. Press the Top key to
return to the top level
menu.

Ink menu

Ink lewel=

sl

The display shows the Ink

menu.

Previous ...
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Message Descriptions

This is a list of the error messages in the front-panel display. If an action is needed, it is shown in italics in the
Explanation and Action column. The messages are listed in alphabetical order. Other front-panel messages,
such as prompts, are included in the descriptions of the relevant procedures elsewhere in this document.

Front Panel Messages

Alignment error due to The printer was aligning its printheads, but encountered an error
printheads. due to some printheads not printing properly. Alignment has
Press ENTER to see faulty stopped.

printheads Press the Enter key.

Cartridges will expire in days: ~ One or more of the cartridges are about to expire. nn is the number

nn of days until expiry date of the cartridge that will expire first. The
cartridges that are about to expire are indicated below this message.
For an explanation of the replacement procedure, see Ink Cartridge
Replacement.

For more Messages, click on the Next Page button
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Message Descriptions N

Front Panel Messages (continued)

Error The printer has detected that one or more of the printheads is
Select Replace Printheads missing or has an error, as indicated by flashing crosses. The four
icons refer from left to right to the Cyan (¢), Black (»), Magenta (e)
and Yellow () printheads.
For an explanation of the replacement procedure, see

Printhead Replacement.

HP is not responsible for The printer has determined that one or more of the printheads is not

damage from use of non-HP an HP product. Your product warranty only applies when you use HP

printheads. printheads. Any damage caused to your printer resulting from the
Replace use of non-HP printheads is not the responsibility of Hewlett-
Continue Packard.

If you want to replace the non-HP printheads, select Replace and

press the Enter key. Otherwise, select Continue and press Enter to
continue.

For more Messages, click on the Next Page button
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Message Descriptions N

Front Panel Messages (continued)

INK CARTRIDGES needtobe  You have attempted to replace printheads, but the printer has

functional. detected that there are ink cartridges that are wrong. The ink
Replace before replacing cartridges must be replaced before the printheads can be replaced.
printheads First replace the faulty, empty or missing ink cartridges and then

replace the printheads. See Ink Cartridge Replacement and
Printhead Replacement.

For more Messages, click on the Next Page button
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Front Panel Messages (continued)

Install missing cartridges You are replacing printheads, but the printer has detected that one
before replacing printheads or more cartridges are missing. The missing cartridges must be
installed before the printheads are replaced.
Follow the procedure for Printhead Replacement. Pressthe Enter or
Cancel key to continue.

Open window and check During system start-up, which occurs when you first install the
proper installation of setup printer, you need to install the setup printheads. These special
printheads printheads cannot be used for printing, but must be used when the

printer has been powered off. The printer has detected that the
setup printheads have not been installed correctly.

Open the window and follow subsequent instructions to reinstall or
relocate the setup printheads. Contact HP for advice if the setup
printheads are missing or cannot be installed correctly.

For more Messages, click on the Next Page button
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Front Panel Messages (continued)

Out of paper The printer ran out of paper while printing the calibration pattern.
Load a sheet or roll that is at least 65 cm (25 inches) long and 50 cm
(20 inches) wide.

Paper advance calibration is You are recommended to perform the Advance calibration routine, to

recommended. Load paper ensure the optimum print quality.
and select Paper advance Load a sheet or roll of paper and then select Advance calibration
calibration. from the Paper menu. See Advance Calibration.

Press ENTER to finish

For more Messages, click on the Next Page button
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Front Panel Messages (continued)

Paper mispositioned The paper is not properly positioned in the printer. Either it is out of
the load line margins or it has moved too much from its previous
position.

Reload the paper following the normal procedure, to solve this
problem. See Loading Roll Media and Loading Sheet Media.

Paper not present. The paper axis calibration routine has been triggered with out
Load paper to print calibration  having paper loaded.
pattern Load paper; see Advance Calibration for details of the routine.

For more Messages, click on the Next Page button
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Front Panel Messages (continued)

Paper too big While loading paper into the printer (roll or sheet), the printer has
Press ENTER to retry found that it is either too wide or too long (only for sheet) to be
Press CANCEL to abort loaded properly.
Press the Enter key to load smaller paper, or the Cancel key to stop
the load.

Paper too small The paper loaded is not big enough to contain the alignment pattern.
to align printheads Unload the paper (select Unload roll or Unload sheet from the
Load bigger size to Paper menu) and then load paper that is large enough—at least A4/
align Letter-size in landscape mode for Standard alignment, or A3/B size
Press ENTER to continue in landscape mode for Special alignment.

For more Messages, click on the Next Page button
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Front Panel Messages (continued)

Paper too small While loading paper into the printer (roll or sheet), the printer has
Press ENTER to retry found that it is either too narrow or too short (only for sheet) to be
Press CANCEL to abort loaded properly.

Press the Enter key to load larger paper, or the Cancel key to stop
the load process.

Pattern not found The printer is trying to perform a scan of the calibration pattern, but
Reload it again, please the pattern was not found.

Reload the sheet that was printed by the Create pattern part of the
calibration routine.

For more Messages, click on the Next Page button
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Front Panel Messages (continued)

Message

Explanation and Action

Printhead replacement not
available now. Cancel print
jobs before replacement

Printhead warning
Poor print quality

JHUE

Printheads not aligned
Paper type not valid

to align printheads

Press ENTER to continue

You have requested the printer to replace one or more printheads,
but the printer is busy printing a job and cannot honor the request
now.

Either: press the Cancel key to cancel the job that is currently
printing, and then again select Replace Printheads (from the Ink
system menu).

Or: wait until the job has finished printing (and there are no more
jobs in the print queue), and then again select Replace Printheads
(from the Ink system menu).

A problem has occurred with one or more printheads. The
printheads are still functional. The problem was detected either
during printhead alignment or during troubleshooting. If you have
completed the routine, the system was unable to clean the
printheads fully.

You should use the Troubleshooting Procedure to correct any image
quality problems that may be apparent; alternatively, you should
replace the printheads (see Printhead Replacement).

You have replaced one or more printheads but the printer has
detected that you do not have the right type of paper loaded for the
alignment process.

Press the Enter key to load the correct type of paper, or the Cancel
key to stop the load process.

For more Messages, click on the Next Page button
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Front Panel Messages (continued)

PRINTHEADS not functional The printer is attempting to print a job, but finds that there is a
Replace printheads problem with the printheads. You may either replace the printheads
Cancel print at this stage or cancel the print.

Select the required option and press the Enter key. If you decide to
replace them, you will be told which ones are failing or missing.

Printheads require alignment.  The printer has detected that the printheads need to be aligned.
Press ENTER to align Press the Enter key to align them. See Printhead Alignment.

For more Messages, click on the Next Page button
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Front Panel Messages (continued)

Problems detected in INK There is an error with the ink cartridges during the preparation of the
CARTRIDGES. ink system.

Continue process and replace  Press the Enter key and then follow the instructions to replace the
them. faulty ink cartridges.

Press ENTER to continue

Replace empty cartridges You have requested the printer to permit the replacement of

before replacing printheads printheads, but the printer has detected that one or more cartridges
are empty. The empty cartridges must be replaced before the
printheads are replaced.
Press the Enter key and follow the procedure for replacing empty
cartridges, described in Ink Cartridge Replacement.

For more Messages, click on the Next Page button
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Front Panel Messages (continued)

Right edge of sheet too far During the loading of a sheet of paper, the printer has detected that
from load line the paper is too far to the left; it should be aligned close to the blue
Press ENTER to retry line painted on the right side of the platen.

Press CANCEL to abort Either: Press the Enter key to restart the loading procedure;

Or: Press the Cancel key to cancel paper loading.

Roll right edge too far from During the loading of a roll of paper, the printer has detected that the
load line paper is too far to the left; it should be aligned with the blue line
Press ENTER to retry painted on the right side of the platen.

Press CANCEL to abort Either: Press the Enter key to restart the loading procedure;

Or: Press the Cancel key to cancel paper loading.

For more Messages, click on the Next Page button
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Front Panel Messages (continued)

Sheet not loaded The printer is trying to perform a scan of the calibration pattern, but
Load sheet with printed no sheet was found.
pattern Load the sheet that was printed by the Create pattern part of the

calibration routine.

Troubleshooting finished The printer has finished the Troubleshooting routine and will not at
Resume normal printing this stage perform further cleaning on the printheads because this
If problem persists select could damage the other ones. However, according to the evaluation
Troubleshooting again you have given, the printheads require cleaning because there are
Press ENTER to continue defects in the Diagnostic Print.

Press the Enter key. Then resume your normal printing activities. If
the problem recurs, try using the Troubleshooting routine again, or
select Replace Printheads from the front panel (in the Ink System
menu) to replace the printheads that are faulty.

For more Messages, click on the Next Page button
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Front Panel Messages (continued)

Unable to initialize ink system.  The system cannot successfully complete the startup.
Call HP representative. Call HP for service.

Unknown ink cartridges. The ink cartridges are not recognized by the printer as ink cartridges
Press ENTER to continue. approved by HP, and there is at least one that is new.
Press the Enter key.

Unknown paper type The type of the paper loaded in the printer is unknown to the printer.
Select paper type Select a known paper type from the printer menu.

For more Messages, click on the Next Page button
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Front Panel Messages (continued)

Warning! The color calibrations for the paper that is loaded have been lost.
Machine calibrations need to Follow the procedure described in Advance Calibration.

be performed. Refer to guide

for instructions.

Warning: printheads not The printer has detected that the printheads have not been aligned
aligned since the last replacement.
You should align the printheads by selecting Align printheads from
the Ink menu.
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Printer Options

The printer has many options that you can use to ensure that the image you print has the look and appearance
you want. You can select printer settings either from the front panel or from the driver you have for the printer. In
most cases the driver settings override the front panel settings.

The Print Options Tab contains these topics:

» Page Format deals with the formatting of the image and how to use the settings to obtain the formatting that
you want. It also explains how to control the orientation of the image on the media.

» Setting Page Size in the Front Panel explains how to set the page size from the front panel.

» Image Appearance describes how to control the overall appearance of your prints.

» Print Management describes how to efficiently manage your printing.

» Printer Configuration details how to set specific configuration parameters of your printer.
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Page Format

» Page Description explains how to make sure the you obtain the prints from your printer in the format you
want.

* Rotating an Image details on how to rotate the image.

» Printing a Mirror Image explains how to print a mirror image of your print.

» Scaling the Image explains how to scale your image from the front panel.
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Page Description
This section explains how to make sure that the printer produces your print in the page format you want.

Y Leading Edge > ]4\
- - I
|

1077”?m ' (0.2in)
©.7in) o ____, |
Page Size Direction of paper

leaving the printer

: 17 mm
: __________________ : (0.7 in)
: Inked Area / :
5 mm [ |
| |
(0.2 in) b o e e e e el ___ R
[ -T T3
o Trailing Edge A
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Page Size

Page size can be specified from the front panel or in the software, where it may be called “Page Size”, “Media
Size”, “Paper Size”, etc., and where the options include, for example, ISO A3, ANSI Letter, Custom. If your
software does not define the page size in the print file, the front-panel setting is used. Otherwise, the software
setting overrides the front-panel setting.

NOTE: There is one exception to the above. If the front-panel setting is Inked area and you are sending
a PostScript file, the front-panel setting is used. See Inked area below.

Margins

The margins are set to ensure the maximum printable area on your paper. The two side margins are 5.0 mm. The

margin settings for the leading and trailing edges are 17 mm.

Printing Area

The printing area is the page size minus the margins. For a table showing the printing areas for standard paper

sizes, see Printable Area.

Inked Area

inked area is the smallest rectangle that contains the entire image.
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Rotating an Image

These topics detail all aspects of job rotation:

Job Rotation Using an HP PostScript Driver
Job Rotation (HP-GL/2)

Page Size and the Rotation

What is Rotated?

Other

Index
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Job Rotation Using an HP PostScript Driver

By default the jobs generated by any of the PostScript drivers provided with the printer are printed in portrait, even
if the image viewed in your application is in landscape orientation. In order to save paper you need to rotate the
job through the PostScript driver interface.

Rotating a job is controlled by a setting in the PostScript driver, it can be enabled or disabled. When you enable
the rotation feature both the page and the image are rotated 90 degrees counterclockwise.

Note that the HP driver will over-ride the setting in the front-panel.
NOTE: Consult the PostScript driver documentation to find out where you set the rotation feature.
Job Rotation (HP-GL/2)

If the software in the driver does not specify the rotation setting, it can be specified in the front panel
(Paper > Page Format > Rotate).
Page Size and the Rotation

Note that when you rotate a job the page size is enlarged to avoid clipping, because the trailing and leading
margins are not the same size as the side margins.

When rotating, the page size is enlarged across the paper direction to ensure that the drawing is not clipped.
Rotating a Job with a Third Party PostScript Driver

If you are using a third party PostScript driver, you can rotate the image using the Rotate setting in the front panel
(Paper > Page Format > Rotate). For more information consult the documentation of the third party driver.
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What is Rotated?
With roll paper, both the image and the page orientation are rotated.

o° o0°

A <

Notice that the narrow margins are always at the left and right sides, regardless of the orientation. The page size
is adjusted to maintain the printing area, preventing clipping.
With sheet paper, the image is rotated, but the page orientation specified in your software is retained. (You should
always load sheet paper in the orientation you have specified in the software.)

0y o0°

A <
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Printing a Mirror Image

If you are using clear imaging paper, sometimes called ‘backlit’, you may want to print a mirror image of your print,
so that when the paper is lit from behind it is in the correct orientation. This can be done from the front panel,

without changing the image in your software.

Mirror Off Mirror On
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Scaling the Image

With a PostScript file, you can enlarge your printed image from the printer's front panel by using the PS Scale

option, accessed from Set-up > PS settings.

The PS scale feature is useful:

» If your software does not support large formats.

« If your file is too large for the printer's memory, and you reduce the page size in your software and then scale
it up again using the front-panel option.

Related Information
» Scaling Factors
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Scaling Factors
To scale your ANSI A PostScript file to:
Required Size ANSI ANSI Arch ANSI Arch Arch ANSI Arch
B C C D D El E E
Use... 129% 200% 210% 258% 282% 352% 400% 419%
To scale your ISO A4 PostScript file to:
Required Size ISO ISONJIS (O] ISO/JIS (O] ISO/JIS
A3 A2 A2 Al Al A0
Use... 129% 200% 210% 258% 352% 400%

The “Fit to page” setting adjusts the image size to the page size selected for your printer. For example, If you have
selected ISO A2 as the page size and you print an A4-size image, it will be enlarged to fit the A2 page. If ISO A4
page size is selected, the printer would reduce a larger image to fit the A4 size.
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Setting Page Size in the Front Panel
* Adjusting the Page Size in the Front Panel

Details how and why you would adjust the Page Size from the Front Panel.

* Page Size
Explains how PostScript Files interpret Page Size.

» Page Size and Clipped Images
Explains what happens if you choose a larger page size than the current media loaded in your printer.

» Page Size and Nesting (Roll Paper Only)
Explains how the Page Size effects Queueing and Nesting
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Adjusting the Page Size in the Front Panel

You do not normally need to adjust the page size through the front panel, because the page size you have

selected in your HP driver overrides the page size selected in the printer. However, some of the circumstances in

which you may want to change the default setting are:

* When you are using the PS Settings > PS Scale > Fit to page feature. See Scaling the Image.

* When you are not using one of the HP drivers supplied with your printer; for example, if you are sending a
PostScript file from a UNIX application.

* When you want to save paper by printing only the inked area of your print, plus the margins. In this case set
Page Format > Size > Inked area.

Depending on the driver you are using, you may not need to change the page size in the front panel. The default
Size setting (Software) in the Page Format menu causes the printer to look for the page size information in the print
file: if it is there, the printer uses it.

However, some of the circumstances in which you may want to change the default setting are:

« If you want to print the inked area only, but the driver you are using does not specify “Inked Area”.

In this case, set the Size setting in the Page Format menu to Inked area.

If you can select Inked area from your driver, any selection you have made in the front-panel menu will be
overridden by the settings in the driver.

* When the prints you are creating need to be of a specific standard (for example, ISO or ANSI), but the actual
size within that standard is not important. For example, your page size may need to conform to a standard ISO
page size, but it does not matter whether the final page size is ISO A4 or ISO A3.

In this case, set Page Format > Size to ISO > Best... or ANSI > Best... etc. The printer uses the
smallest standard size into which the inked area will fit.
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Page Size

Unless you are using the front-panel Page Format > PS Scaling > Fit to page option (see page Scaling the
Image), the front-panel page-size settings have no effect on PostScript files that already contain page-size
information, which includes all PostScript files sent using one of the HP DesignJet PostScript drivers supplied with

this printer.

If you are using the Page Format > PS Scaling > Fit to page option, then the printer uses the page size set in the

printer’s front panel as follows:

» If the page size is set to a discrete size, it uses the specified page size.

» If the page size is set to Software, the printer calculates the page width as the width of the loaded paper, and
the page length as 1.5 times the width of the loaded paper.

» If the page size is set to Inked area, the printer calculates the page width as the width of the loaded paper and
the page length as the height of the inked area plus the top and bottom margins of the page.

« If the page size is set to a “Best...” option, the printer calculates the page length as 1.5 times the page width.
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Page Size and Clipped Images
If you specify in your software a page size that is larger than the paper size loaded in the printer, the printer will still
print what it can, but may clip your image.

A2 paper in printer

Clipped "=~~~ ~~~~~~
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Page Size and Nesting (Roll Paper Only)
Nesting means placing two or more pages side-by-side on a roll to save paper. There are certain cases when your
prints can not be nested. For a complete explanation of nesting, see Nesting Pages.

If you have gueueing and nesting switched on, the printer will use the page size to determine which pages are
nested and whether the pages can be automatically rotated when nesting. See When Does the Printer Try to Nest

Pages? for information about which pages can be automatically rotated.
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Image Appearance

These topics explain how you can control the overall appearance of your prints.

» Front Panel Image Options
explains how to change the HP-GL/2 color palettes.

 Printing Images in Grayscale
describes how to print color images in grayscale.

» Print Speeds and Print Quality
lists typical printing times by output quality.

» Print Quality

describes the different print modes that are available with your printer.

» Advanced Options
describes the various optimization and quality enhancement methods available.
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Front Panel Image Options

These topics deal with the ways you can control the overall appearance of your prints from the front panel in
terms of:

* Pen Widths and Colors in the Internal Palettes

» Changing the Treatment of Overlapping Lines (Merge)

Some front-panel selections affect the next file you send from your computer, not pages already in the printer’'s
gueue. If this is the case, it is stated in the relevant topic.

Some of the controls are available using the front-panel menus (for example) pen width, pen color, overlapping
lines). Print mode options are controlled from the front-panel.

Why Use the Front Panel?

By default, the printer looks to your software to provide information on all the above attributes. However, your
driver or application may not provide these controls or you may want to experiment with various effects, or try a
temporary change, without the need to change your images or your driver settings.

Some of these settings do not affect the output generated when printing from most of the applications under
Windows when using a HP-GL/2 driver.
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Pen Widths and Colors in the Internal Palettes

The “pens” discussed throughout these topics are the conceptual pens in a software palette, rather than the
printer’s physical printheads.
The printer has three pen palettes:

e Factory
 Palette A
+ Palette B.

The factory palette cannot be changed. You can, however, change the line width and color settings for each pen in
the remaining two palettes (palette A and palette B). Initially, all three palettes are identical. Each palette has 16
pens which can include pens of different widths and any combination of the printer’s predefined 256 colors.

Related Information
* To Select a Palette

¢ Change the Palette Settings

 How to Define Palette A
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To Select a Palette

To select a palette through the front-panel menu, go to the Define Palette selection under HP-GL/2 Settings and
choose the palette you want. See Set-up Menu.

The following table describes the palette choices.

Palette Comments
Software The printer looks to your software for pen settings and ignores all three internal palettes.
Palette A The printer assigns the attributes defined in Palette A to the pens defined in your software

as 0 through 15.

Palette B The printer assigns the attributes defined in Palette B to the pens defined in your software
as 0 through 15.

Factory The printer assigns the attributes defined in the Factory Palette to the pens defined in your
software as 0 through 15.
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Change the Palette Settings
You cannot change the Factory palette, but you can define Palettes A and B to be whatever you choose. The
defaults are Palette, width:

Item Available Options Defaults
Palettes Factory, A, B. Factory
Pens 0 through 15.

Widths (mm) 0.13, 0.18, 0.25, 0.35, 0.50, 0.65, 0.70, 0.80, 0.90, 1.00, 0.13 mm
1.40, 2.00, 3.00, 5.00, 8.00, 12.00.
Note that 0.13 mm is a one-pixel line width at 300 dpi
and three-pixels line width at 600 dpi.
Colors 0 through 255. As specified on the Palette
Print.

How to Define Palette A
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How to Define Palette A
The following steps explain how to define Palette A.

Instructions Select (using the § keys) ~ Then Press:
1. Set-up menu Enter
2. HP-GL/2 Enter
Select Palette A )
3. Define palette Enter
4, Palette A Enter
5. Select pen to change (in this example 3). Pen 3 Enter
6. The current width assigned to this pen is . _
displayed, for example Width=0.13mm. Width =0.13mm Enter
Scroll to the width you want. 0.35mm Enter > Back
Scroll to Color. The current color
assigned to the pen is displayed (in this Color =4 Enter
example 4)
9. Scroll to the color you want. Color =110 Enter > Back
D If both width and color are correct (for Pen 3 Top

Pen 3), press Back four times

Repeat this procedure to define each of the other pens.

NOTE: The palette you have just defined will take effect only when you select it to be
the current palette, as explained in To Select a Palette.
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Changing the Treatment of Overlapping Lines (Merge)
The Merge setting controls the overlapping lines in an image. There are two settings, Off and On. The following
illustration shows the effect of each setting.

Mer ge off (Default) Mergeon

A subsequent line hides a Overlapping lines and area
previous line where they fills are merged.

overlap.

You can set the merge setting from your software in some applications. Settings in your software override the
front-panel settings.
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Printing Images in Grayscale

There are times when you may want to print a color image in grayscale because it is faster. Examples of this are:
* You want a draft where color is not important, for example to check that the image is not going to be clipped.
* You want a version for photocopying in black and white.

When you choose the Ink menu Color settings > Grayscale option, the printer renders colors as Grayscale rather.
If you only want to use black ink to print in grayscale, you should select the Ink menu Color settings > True black
option.

NOTE: You cannot change the color/grayscale setting for pages already in the printer's queue.
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Print Speeds and Print Quality

The following table lists some Typical Printing Times (line drawings @ 20-25°C and 30-60% relative humidity).
Typical Printing Times

ANSI-D size ANSI-E size
Paper Color/Grayscale Quality
Time (in secs) | Time (in secs)
Bright White Color Best 235 440
Normal 120 225
Draft 45 85
Grayscale Best 135 250
Normal 80 150
Draft 45 80
Coated Paper Color Best 490 980
Normal 120 225
Draft 85 160
Grayscale Best 325 625
Normal 135 250
Draft 45 80

More Printing Times
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Typical Printing Times (continued)
ANSI-D size ANSI-E size
Paper Color/Grayscale Quality
Time (in secs) | Time (in secs)
Heavy Color Best 490 980
Coated Paper Normal 120 225
Draft 85 160
Grayscale Best 435 870
Normal 135 250
Draft 45 80
Glossy Paper Color Best 630 1200
Normal 435 830
Draft 325 620
Grayscale Best 630 1200
Normal 435 830
Draft 325 620
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Print Quality

You can set the overall print quality from the front panel (Set-Up > Print Quality).

In general choose:

» Fast for maximum productivity. Ideal for checking prints, when print quality is not the most important. You can
reduce print speed if it is causing image quality problems with the Fast Quality Settings.

* Normal to get a good combination of print quality and productivity. Ideal for line drawings with good print
quality and at speed.

» Best to get the high image quality. You can increase the resolution of the Best setting with the Best Quality

Settings.
You can print images in different settings to see which gives the best combination of throughput and quality for
your application.
See Print Resolution for information on what resolution is used with each print quality setting.
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Advanced Options

Your HP DesignJet 800PS printer provides several advanced optimization and quality enhancement features to
allow you to obtain the printed results you require.

e Improving Line Quality and Graphics Details

» Best Quality Settings
» Fast Quality Settings
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Improving Line Quality and Graphics Details

The Set-up menu Optimize for option allows you the select the correct mode for the type of job you are printing.
Two modes are provided: Line drawings/text and Images.

Selecting the Line drawings/text option smooths the fine graduations along the angles and curves of the printed
image to refine the overall print quality. This enhancement produces:

» Crisper lines.

*  Finer detail.

* Line drawings with a ‘sharp’ appearance.

The Line drawings/text option only affects prints that have color content.

Selecting Line drawings/text (the default setting) ensures you will always get the best quality color prints, except
when printing the following files:

* Mixed lines and scanned color images.
* Mixed lines and color photographs.

For these files it is recommended that you select Optimize for > Images.
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Best Quality Settings

If you have selected the Best option as the Print Quality setting for you print session but require an even higher
resolution for your print job, you will need to change the Best quality setting.

The Best Print quality option provides 600x600 dpi resolution in normal mode and 2400x1200 dpi in maximum
detail mode.

NOTE: Using the maximum detail mode will improve resolution but will reduce printing speed and
increase memory requirements.

Use the following procedure to increase the Best quality print resolution:

Select (using the § keys) Then Press:
1. Set-up Enter
2. Advanced Options Enter
3. Best quality settings Enter
4. Maximum detail Enter
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Fast Quality Settings

If you have selected the Fast option as the Print Quality setting for you print session and this high speed mode
causes an unacceptable image quality you will need to reduce the printing speed. This can only be done from the
front panel of the printer because it is not available as an option in the printer driver.

Use the following procedure to reduce the Fast print quality printing speed:

Select (using the § keys) Then Press:
1. Set-up Enter
2. Advanced Options Enter
3. Fast quality settings Enter
4. Reduced speed Enter
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Print Management

These topics describe the best methods of managing the work that the printer is doing.

» Cancelling a Page that is Printing
Shows you how to cancel a page that is currently being printed.

» Cancelling the Drying Time
Shows you how release a page from the printer before the drying time has finished.

» Managing the Queue
Details how to manage job queueing for maximum efficiency.

* Nesting Pages
Explains how to nest prints to minimize your usage of roll media.
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Cancelling a Page that is Printing
Use the following procedure to cancel a page that is currently being printed.

1. Press the Cancel key on the front panel.

Cancel Key

The printer advances the paper as though the print were finished. A multi-page job or a big file may take
longer to stop printing than other files.
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Cancelling the Drying Time

CAUTION: Use caution when performing this procedure as an image which has had insufficient time to dry
could get damaged.

Use the following procedure to cancel the drying time for a job that is waiting for the end of drying time.
1. Press Cancel or Form Feed & Cut on the front panel.

Cancel Key

enigine.bmp
Ink drwing
2 mih 22 Zec 'ﬁ]

Form Feed & Cut Key
The printer will release the printer and it will fall into the paper bin.
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Managing the Queue

These topics explain how the queueing function operates and how to use to manage your print jobs.
e What is the Queue?

» Printing with Queueing Turned ON

e Printing with Queueing Turned Off

e Starting to Print a File that is Waiting for a Time-out

» |dentifying a Job in the Queue

e Prioritizing a Job in the Queue

e Prioritizing a Job in the Queue

* Making Copies of a Job in the Queue
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What is the Queue?

Your printer can store pages in a queue at the same time as printing the current page. It stores them page by

page. If you send only a single-page, you can regard these as files.

The size of the queue is limited by number of jobs (maximum of 32 jobs) and the total memory available.

The queue stores processed output pages, not the input jobs.

NOTE: If you send a very complex PostScript job with Queueing Off, the printer may stop during
printing of the image while it is processing the job. This may result in an image quality defect.
To avoid this, always print very complex files with Queueing On.

When Queueing is On and the printer receives print files, the files are stored in the queue in the
order they are received. If Nesting is Off (the default), the files are printed as soon as possible, in
the order they are received. If Nesting is On, files are printed when the time-out period expires or
there are enough files to fill a page width. You can re-send files which have already been
printed.
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Printing with Queueing Turned ON

You can send pages to the printer without waiting for the current page to finish printing.

Pages are stored in the queue in the order they are received.

You can manipulate the pages in the queue, for example prioritizing them and reprinting them.
You can use nesting, the printer's paper-saving feature (see Nesting Pages).

While one page is printing, the printer will accept and process the next file.

Index
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Printing with Queueing Turned Off

If Queueing is Off and the printer receives print files, the files are printed as they are received, and are not stored in

the queue. Nesting settings have no effect when Queueing is Off.

» Files are printed as they are received, and are not stored in the queue.

» The printer will not accept another file sent from the computer until the current page has finished printing and
the printer is ready.

* You cannot use nesting.

If you turn queueing off while pages are still in the queue, they will be printed and (if nesting is on) nested, until the

gueue is empty.

NOTE: If the printer is turned off with files in the queue that have not been printed, the files are lost

and must be resent.
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Starting to Print a File that is Waiting for a Time-out

If all is in order (paper loaded, all ink components installed, and no file errors), there are still reasons why a file you

have sent from your computer may not start printing when expected:

» The print file may lack a proper file terminator and the printer is therefore waiting for the specified I/O time-out
period before assuming it is complete. See To Change the I/O Time-out Setting.

* Nesting may be On and the printer is waiting for the specified nest wait time-out period before calculating the
appropriate nests. In this case, the printer display shows the remaining time for the nesting time-out. See How
Long does the Printer Wait for Another File?

» If your file has selected sheet or roll paper for printing the job, but the selected paper is not loaded into the
printer:

— The front panel will prompt you to load the selected paper; once you have loaded the paper the printer will
print the job.
— Press the Cancel key and re-send the job with paper that you have available.
If you want to override the time-out period and start printing, press the Form Feed and Cut key on the front panel.

Form Feed
and Cut Key
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Identifying a Job in the Queue
In Queueing & Nesting, you can scroll through the pages in the queue.

The queue positioning operates as follows:

The job currently being printed is in position 0.
The next job to be printed is in position 1.

The one after in position 2, etc. ...

The previous job printed is in position -1

The one before that in position -2, etc. ...

r Job name

Jobs already printed ——  |Gueus '/

-3 axle.gif

-1 gearbox.gif
Currentjob ——— |@= Job #7
12 engine.gif

Jobs yet to be printed —— \
Position in queue

Other Index

Up to 32

Jo
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Prioritizing a Job in the Queue
To make any job in the queue the next one to be printed, highlight it in the queue and press Enter. Then you must
choose the Move to top menu option to make the job the next one to be printed.

If Nesting is turned On (see What is Nesting?) the prioritized job may still be nested with others. If you really want
this job to be printed without nesting, then first turn nesting off and then use Move to top to make it the next job in
the queue.

Deleting a Job from the Queue

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will just “fall off
the end” of the queue as more files are sent. However, if you have sent a file in error and want to avoid any chance
of it being reprinted, you can simply delete it, by selecting it and choosing Delete.

To remove a job that has not yet been printed, simply identify it by its position in the queue (see Prioritizing a Job
in the Queue) and delete it, by choosing Delete.

If the job is currently being printed (its queue position is 0), and you want both to cancel the job and to delete it,
first press the Cancel key and then delete it from the queue.
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Making Copies of a Job in the Queue

Has the Jop already Do you want one copy What to do
been printed? or several?
Yes One Use Move to top (see Prioritizing a Job in the Queue).
Several Use Reprints (see below) and then use Move to top (see
Prioritizing a Job in the Queue).
No One or Several Use Copies (see below).

In all cases, the job must still be in the queue. Use the following procedure to make copies of a job in the queue:

NOTE: The setting you specify in this option overrides any value set by your software.
NOTE: If Rotate (see page Rotating an Image) was On when you sent the file, every copy will also be
rotated.

Copies and Reprints
1. Select the job and choose Copies or Reprints (from the Job Management menu).

2. Use the scrolling keys to specify the number of copies required and press Enter.
The number you enter is the actual number of pages to be printed; for example, choosing 2 for a page not yet
printed means you will get the one original and one copy. The maximum is 99.

If you want to cancel a Copies or Reprints selection choose the Cancel menu option for the file you have selected
to print copies or reprints.
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Nesting Pages

What is Nesting?
When Does the Printer Try to Nest Pages?

Which Pages Qualify for Nesting?

Turning Nesting On and Off

What Happens to Nesting if You Turn Queueing Off?

How Long does the Printer Wait for Another File?

Other

Index
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What is Nesting?
Nesting means placing pages side-by-side on the paper (rather than one after the other), to avoid wasting paper.

NOTE: Nesting can only be used with roll media.
Direction of ‘ Direction of
paper flow paper flow
Paper Saved

Nesting off Nesting on
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When Does the Printer Try to Nest Pages?

When all the following are true:

» The printer is loaded with roll paper rather than sheet paper.

* In the front-panel menus, Queueis On (the default). See What is the Queue?
* In the front-panel menus, Nest is On. See Turning Nesting On and Off.

Which Pages Qualify for Nesting?

In order to be in the same nest, the individual pages must be compatible on the following criteria:

» Color or grayscale.

NOTE: Either all are color or all are grayscale.

» Files must be at the same dots per inch setting.

» All pages must have the same print quality setting (Best, Normal, Draft).
* Margin sizes must be the same for all pages (normal or extended).

» All pages must be the same graphics language.

* Equal mirror setting

Index
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Turning Nesting On and Off

To enable or disable nesting, select Nest from the Job Management menu and choose On or Off.

« On The printer will search all through the queue for suitable pages. It will nest the pages according to an
algorithm that, for most combinations of page sizes, saves the most paper. The resulting nesting
pattern may still vary, depending on the size of the first page.

o Off The printer will not nest pages.
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What Happens to Nesting if You Turn Queueing Off?

Turning queueing off does not turn nesting off for pages already in the queue. The printer prints all the pages in
the queue before accepting any more files. As soon as you turn queueing off, the nesting setting also changes to
off. When queueing is turned on again, the printer restores nesting to its previous setting.

How Long does the Printer Wait for Another File?

So that the printer can make the best nest possible, it waits after a file has been received to check if a subsequent
page will nest with it or with pages already in the queue. This waiting period is the nest wait time; the factory
default time is two minutes. This means that the printer waits for up to two minutes after the last file is received
before printing the final nest. You can change this waiting time using the front panel menu. The available range is
1 to 99 minutes.

While the printer is waiting for nesting to time-out, it displays the remaining time in the front-panel display. You can
print the nest (cancel the nest wait) by pressing the Form Feed and Cut key.
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Printer Configuration

These topics explain how to change the configuration of your printer.

Printer Information

Front Panel Setup

Altitude Setting
Changing the Graphics Language

Graphics Language and Networks
Setting up the 1/O Card
Controlling the Cutter

Upgrading Your Printer

Color Settings
Postscript Encoding

Logs

Other

Index
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Printer Information

Your HP DesignJet 800PS printer provides an information display on the front panel that shows the current
configuration of the system. You can also print out this information directly on your printer.

Select Set-up > Printer information > View to view the information or Printer information > Print to print it.
The printer information screen shows the following information about your printer:

*  Model Number e Scan Axis Usage

e Serial Number e Paper Axis Usage

e Service ID « Service Station Usage
* Firmware Rev. e Spittoon Usage

* Accessory Rev. e Pinch Lift Usage

» Paper Used e Cutter usage

* Inkused (C, M, Y, K) e Ink Usage
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Front Panel Setup

You can configure the following parameters for the front panel:

 Menu and Message Language

o Alert Buzzer
e Screen Contrast

Other

Index
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Menu and Message Language

The following languages can be used for all menus and messages shown on the front panel of your
HP DesignJet 800PS printer:

* English
» German
* Spanish
e Catalan
* French
e ltalian

* Japanese

» Portuguese

» Korean

» Simplified Chinese

* Traditional Chinese

To change the language:

1. Select the Front Panel > Language option from the Set-up menu.

2. To scroll to the language you require and press Enter.
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Alert Buzzer

Your HP DesignJet 800PS printer is equipped with an alert buzzer that is used to warn you when:

» Atask has completed.
* An error has been detected.
* You change a parameter from the front panel.

To enable or disable the buzzer:
1. Select the Front Panel > Buzzer option from the Set-up menu.
2. Highlight Buzzer = On or Buzzer = Off (whichever is displayed) and press Enter.

3. Scroll to the option you require, On or Off, and press Enter.

Index
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Screen Contrast

You can adjust the screen contrast of the front panel to best suit the ambient lighting conditions at your location.
The contrast can be varied from 0% to 100% in 5% increments. The default setting is 50% and is suitable for most
situations.

To adjust the screen contrast:
1. Select the Front Panel > Contrast option from the Set-up menu.
NOTE: Any value below 20% shows a blank screen and any value over 80% shows a black screen.

2. Scroll to the required value and press Enter.
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Altitude Setting

Your HP DesignJet 800PS printer contains a vacuum pump which is used to hold the media onto the platen. The
altitude of your location effects the efficiency of this pump so you need to specify the altitude to ensure the pump
operates correctly.

To set the altitude:

1. Select the Altitude option from the Set-up menu.

2. Scroll to the required value (0 - 2000m, 1000m to 2000m, or > 2000m) and press Enter.
The following table shows the corresponding altitude values in feet.

Meters Feet

0-1000 0 - 3300

1000 - 2000 | 3300 - 6600
> 2000 >6600
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Changing the Graphics Language
Your software application uses a graphics language to communicate with the printer. The printer's default
language setting is called Automatic and works for most software applications.

In Automatic mode, the printer determines which type of file it is receiving, such as PostScript or HP-GL/2, and
prints it. Unless you are experiencing printing problems you should not need to change this default.

See To Change the Graphics Language Setting to modify this setting.
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To Change the Graphics Language Setting
To change the graphics language setting, go to the Setup > Graphic Language menu. The following selections

are available:

Graphics Language Settings

Language Comments
Automatic Choose Automatic to let the printer determine which type of file it is
receiving. This setting works for most software applications.
PostScript Choose PostScript if you are printing only PostScript files and your
PostScript jobs do not include PJL language switching commands.
HP-GL/2 Choose this setting if you are not working with PostScript files and:
» you have experienced image position problems;
* you have experienced timing problems.
CALS G4 Choose this setting if your files are in the CALS G4 language. This

must be selected because the Automatic setting is not sufficient. If
you select the CALS G4 setting to print a CALS file, the printer must
be returned to the default setting afterwards to enable printing in other
languages.
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Graphics Language and Networks

For System Administrators

If you are using the printer with a network spooler, consider having your system administrator modify the spooler
to insert automatically the PJL language-switching commands at the beginning and end of each file. This allows
the printer to switch automatically into the correct graphics language for your current print and returns the printer
to the front-panel graphics language setting for subsequent prints.

For information on ordering PJL reference information, see Ordering Accessories.

The HP PostScript printer driver for Windows provided with your printer, adds the PJL language-switching
commands to your output file, allowing the printer to switch graphics languages automatically.
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Setting up the 1/O Card

Network
With a network interface (such as the HP JetDirect Print Server), refer to your network interface documentation for
advice on any front-panel configuration. The front-panel menu is I/O Setup > Card Set-up.

To Change the I/O Time-out Setting

Some software applications do not write a file terminator at the end of a file. In this case, the printer does not know
when the file is complete and will wait for more data until the end of the “I/O Time-out” period. By default, this
period is 30 minutes. You can change the time-out setting in the front-panel menu
(Set-Up > 1/O setup > I/0O Timeout) to as little as 30 seconds.
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Controlling the Cutter

With roll media loaded, when any print job you have send to the printer completes, the roll is automatically cut and
the print job falls into the media bin. There may be a delay before the roll is cut due to the drying time you have
programmed or the printer has automatically selected.

In some situations you may not wish to cut the roll after each print job. Use the following procedure to control the
cutter. The front panel menu selections are:

Select (using the § keys) Then Press:
1. Paper menu Enter
2. Cutter Enter

3. ONor OFF Enter
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Upgrading Your Printer

System Software
“System Software” is the name given to a type of software which runs the functions in your printer.

System Software downloading

From time to time there will be system software upgrades available from Hewlett-Packard. System software
upgrades increase your printers functionality and enhances the features that your printer already possesses.
System software can be downloaded from the Internet.

For the latest upgrades, go to_http//www.hp.com/go/designjet. Follow the on-screen directions.



http//www.hp.com/go/designjet
http://www.hp.com/go/designjet
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Color Settings

Your printer can emulate the color behavior of offset printing presses, allowing you to use your printer for color
proofing. To get accurate colors for your proof, select the color emulation mode that matches your offset printing
standards from the Ink menu Color settings option. The selections are:

Color/monochrome

Refer to Printing Images in Grayscale for further details

»  Color—the printer prints in color

» Grayscale—the printer prints the color image in grey shades.

» True black—the printer prints the color image in grey shades using black ink only.

RGB
* Native/Device RGB—No ink emulation
« sRGB—Standard RGB

CMYK
* Native/Device CMYK—No ink emulation
«  SWOP—U.S. Specification for Web Offset Printing
» EuroScale—European standard for offset press.
« TOYO—Japanese standard for offset press
e DIC—Dainippon Ink and Chemicals, Inc.

Rendering Intent
e Perceptual

e  Saturation

« Colorimetric
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Postscript Encoding

Your printer provides a manual method of selecting the type of file encoding for PostScript files. Normally you
should never need to change the default Automatic encoding which detects the type of file encoding when the

printer receives the file.

There are however rare cases caused by combinations of applications and third party drives that produce
PostScript files that the printer cannot automatically detect what type of encoding has been used. Whenever this
happens the printer will display a error message on the front panel.

To print the file you must first check what type of encoding has been selected with your driver and then make the
corresponding selection with the Set-Up menu PS settings option. In addition to Automatic encoding two other
encoding types are available: ASCII and Binary.
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Logs
Your HP DesignJet 800PS printer keeps a log for the printheads and an error log. These logs are normally used
by service engineers.

Printhead Log

The printhead log contains a list of the last five printheads of each color along with information about the usage of
the printhead.

Error Log

Lists the last errors detected the printer has detected along with the date the error occurred and a unique error
code for the type of error detected.
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Other

The Other tab provides miscellaneous procedures and information that may be required to ensure your printer
remains in a fully operational condition at all times.

The Other tab contains these sections:
e Care of the Printer

¢ Installing Expansion Cards

» Specifications
* Ordering Accessories

* Glossary
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Care of the Printer

This section contains information on general maintenance of the printer.

» Cleaning the Printer
Instructions for cleaning the exterior of your printer.

» Storing and Moving Your Printer
Instructions on how to move and store your printer.

Index
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Cleaning the Printer

WARNING: To avoid an electric shock, make sure that the printer is switched OFF and disconnected from
the mains supply before you clean it. Do not let water get inside the printer.

CAUTION: Do not use abrasive cleaners on the printer.

NOTE: Any maintenance or repairs beyond those described in this chapter should be done by a
qualified service technician.

Cleaning the Printer Exterior

Clean the outside of the printer as required with a damp sponge or a soft cloth and a mild household cleaner such
as non-abrasive liquid soap.
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Storing and Moving Your Printer

If you need to move your printer or store it for an extended period of time, you need to prepare your printer
properly to avoid possible damage to the printer. To prepare your printer, follow the instructions given below:

CAUTION: 1t is important that you do not remove the Ink Cartridges and Printheads before moving or
storing the printer.

1. Switch the power off at the On/Off power switch on the front of the printer.
2. Disconnect any cables connected to the printer; parallel interface, LAN connection.

3. Repack the printer in its original packaging. Refer to Assembly/Repacking Instructions available on the HP
web-site (www.hp.com/go/designjet) for details.

4. If you have to move your printer you will need the original packaging. If necessary you can order a kit of the
packaging materials. Contact HP support and they will supply it to you. If necessary they will repackage the
printer for you.


http://www.hp.com/go/designJet
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Installing Expansion Cards

The following options are available for your HP DesignJet 800PS printer:
* Network Card Installation
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Network Card Installation

An HP JetDirect Network Card is installed in your printer when you buy it. If you wish to use a different network
card install it using the following procedure:

HP JetDirect Network Card Installation

1. Before installing a card, switch off the
printer and unplug it from the mains elec-
tricity supply.

2. Carefully remove the plastic cover from the
left-hand back of the printer by unclipping it.
This cover gives access to the two slots for
an Accessory card and a LAN card.

* Press in the thumb-tab on the side fur-
thest from the edge that has the cable-
hole.

« Ease the cover out in the direction of
the embossed arrow, pivoting it by the
hinge clips on the side that has the
edge cable-hole.

Continued ...
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HP JetDirect Network Card Installation (Continued)

Printer
Options

Index

Remove the cover completely Inside the
compartment there are two slots for a LAN
card or an Accessory card.

You can use either slot for either card, but
we recommend putting a LAN card on the
left (nearer to the front of the printer) and an
Accessory card on the right. In this way the
cable from the LAN card can easily pass
through the slot in the door.

To insert a LAN card (or an Accessory
card), remove the metal cover from the
appropriate slot by unscrewing its two
screws. You can use a screwdriver or do it
manually.

When you have inserted the card, screw it
into place, using its two screws (at the top
and bottom of the card). Again, this can be
done with a screwdriver or manually.

Previous ...

Continued ...
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HP JetDirect Network Card Installation (Continued)

6. Insertthe LAN cable into the LAN card. It is
simply pushed into place and clicks when
locked.

7. Carefully replace the plastic cover by
clipping it back into place:

* Put the two hinge clips on the side that
has the edge cable-hole into their slots.

¢ Swivel the cover in the direction oppo-
site to the embossed arrow and clip the
other two tabs on the opposite side into
their slots. Ensure that the LAN cable
passes correctly through the edge
cable-hole (shown by the yellow arrow).

e Take care to carefully route the LAN
cable so it does not interfere with the
spindle or roll.

8. Once you have completed the physical installation of the card you will have to configure
it for you LAN, see Setting up the I/O Card.

Previous ...
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HP-GL2 Accessory Card Installation

Not available for your printer model.
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Functional Specifications

Memory Specifications

Printer Power Specifications

Ecological Specifications

Enviromental Specifications

Acoustic Specifications

Connection Specifications
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Index
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Functional Specifications

HP DesignJet 800PS Functional Specifications

Functional Specifications
Four colors: cyan, magenta, yellow and black.
36 kHz (Cyan, Magenta, Yellow).
Printheads: 600 dpi, (Cy g )
HP Ink 36 kHz (Black).
Supplies Cyan
Supplies _ Magenta
Ink Cartridges contents: 69 ml
Yellow
Black
. Width (carriage axis) Length (paper axis)
Paper sizes — - = :
Minimum Maximum Minimum Maximum
Roll - D/A1 size 625 mm 100 mm
printer 25 inches 1000 mm 4 inches
Roll - AO+/ 1071.8 mm 40 inches roll external
E+ size printer |140 mm 42.2 inches diameter
Sheet -D/ 5.5 inches 625 mm
Al size printer 25 inches 140 mm 1897 mm
Sheet -A0+/ 1071.8 mm 5.5 inches 74.7 inches
E+ size printer 42.2 inches

More ...
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HP DesignJet 800PS Functional Specifications (Continued)
Functional Specifications
HP Supported Media?
HP Bright White Inkjet Paper (Bond)
HP Vellum
HP Natural Tracing Paper
HP Coated Paper
HP Heavyweight Coated Paper
HP Matte film
HP High-Gloss Photo Paper
HP Semi-Gloss Photo Paper
HP Paper-Based Semi-Gloss
HP Clear film
HP Translucent bond
HP Studio Canvas
HP Satin Poster Paper
HP Banners with Tyvek®
HP Colorfast Adhesive Vinyl
Previous ... More ...
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HP DesignJet 800PS Functional Specifications (Continued)
Functional Specifications
Resolution Print Mode Line drawing/text |lmage
Fast Render 300x300dpi 150x150 dpi
Halftone 600x300 dpi 600x300 dpi
Normal Render 600x600 dpi 300x300 dpi
Halftone 600x600 dpi 600x300 dpi
Best (default) Render 600x600 dpi 600x600 dpi
Halftone 600x600 dpi 600x600 dpi
Best Render 600x600 dpi 1200x1200 dpi
(maximum detail) [Haftone 1200x600 dpi 2400x1200P dpi
Previous ... More ...
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HP DesignJet 800PS Functional Specifications (Continued)

Printer
Options
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Functional Specifications

Margins Roll (normal) Sheet (normal) Roll (small) Sheet (small)
Side Margins 5 mm
Leading Edge Margin 17 mm
Trailing Edge Margin 17 mm

Graphics HP-GL/2

languages HP-RTL

supported CALRASTER
Adobe PostScript 3 (supports Asian fonts)

Accuracy 0.2% of the specified vector length at 23° (73°F), 50-60% Relative Humidity, on
HP special polyester film.

Previous ...

a. From time to time, new paper types may become available. For up-to-date information, please

contact your HP dealer or our web site www.designjet-online.hp.com.

b. Glossy Photo Media Only
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Physical Specifications

Physical Specifications
Type Weight Width Depth Height
D/A1 size printer | 38.5 kg 1253 mm 470 mm 349 mm

851b 49 inches 19 inches 14 inches
AO+/E+ size 45 kg 1690 mm 674 mm 1100 mm
printer 99 1b 67 inches 27 inches 43 inches
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Memory Specifications

Memory Specifications

Internal RAM 160MB
Hard Disk 6 GB
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Printer Power Specifications

Printer Power Specifications

Source 100-240 V AC +10% auto-ranging

Frequency 50/60 Hz

Current 3 amp maximum

Consumption 150 watts maximum
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Ecological Specifications

Ecological Specifications

Energy efficiency |Compliant with Energy Star Program EPA (US).

Manufacturing Free of ozone-depleting chemicals (Montreal Protocol).

process

Plastics Free of brominated flame retardants (PBB and PBDE).
All housing parts made of the same material: ABS.
Parts marked according to ISO 11469 standard.

Metals Enclosures made of electro-galvanized steel sheet.

Packaging Cardboard (non-chlorine-bleached) and foam are 100% recyclable.
Inks used for printing do not contain heavy metals.

User Majority provided in Adobe Acrobat PDF format on CD-ROM

Documentation

Batteries Not used.

Recyclablility Modular construction, screws easy to find and disassembly done
using universal tools.

Index



Printer

Introduction Media & Ink Solutions Front Panel Options Index
Enviromental Specifications
Environmental Specifications
Operating Ranges | Printing: 15°C to 35°C (59° F to 95° F) RH 20% to
70%.
Optimal print quality for HP | 15°C to 30°C (59° F to 86° F) RH 20% to
glossy media: 80%.
Optimal print quality for other |15°C to 35°C (59° F to 95° F) RH 20% to
HP media: 70%.
Non Operating Printer: -40°C to 70°C (-40° F to 158° F)
Ranges Packed consumable items  |-40°C to 60°C (-40° F to 140° F)
and system:

NOTE: At altitudes greater then 3000m the printer may have operational problems.
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Acoustic Specifications

Printer

Front Panel Options

Acoustic Specifications

Operating sound pressure

54 dB (From a one-meter bystander position)

Idle sound pressure

<30dB (A) (From a one-meter bystander
position)

Operating sound power

6.5 Bels (A)

Idle sound power

<4.3 Bels (A)

Index
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Connection Specifications

» Cable Specification

» Recommended Cables




Printer

Introduction Media & Ink Solutions Front Panel Options

Index

Cable Specification

The connector on the printer is 36-pin female connector. Most existing parallel cables support IEEE-1284
compatible communication, but for use with this printer, the cable must meet the specifications in the following
table:

Parallel (IEEE-1284 compatible/Centronics) Interface

Pin Wire/Signal Name Source

1 Strobe computer
2.9 DO ... D7 (data lines) both

10 Ack printer
11 Busy printer
12 PError printer
13 Select (SelectOut) printer
14 AutoFd computer
16 GND

19 ... 30 GND

31 Init computer
32 Fault printer
36 Selectin computer
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Recommended Cables

Printer
Options

Index

The following cable is recommended for optimum performance and electromagnetic compatibility:

Recommended Cable

Interface type (Computer) HP part number Cable length Connector type at
computer end of
cable

IEEE compatible/Centronics C2951A 3.0m 25-pin male

Interface (All)

uUsB C2392A 50m USB plug
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Ordering Accessories

You can order supplies and accessories in any of the following ways:

» Call your local authorized HP dealer.

e Contact your local HP Sales and Support office.

» Refer to the Hewlett-Packard Support / Services booklet that was supplied with your printer.

» Documentation
» Hardware
e Consumable Items
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Documentation

Language Pocket Guide User’s Reference Unpacking and
Guide Assembly poster
HP Part Numbers
Chinese C7769-90020 C7769-90131 C7769-90040
Czech C7769-90021 Not available Not available
English C7769-90011 C7769-90131 C7769-90031
French C7769-90015 C7769-90135 C7769-90035
German C7769-90014 C7769-90134 C7769-90034
Greek C7769-90022 Not available Not available
Hungarian C7769-90023 Not available Not available
Italian C7769-90017 C7769-90137 C7769-90037
Japanese C7769-90018 C7769-90138 C7769-90038
Korean C7769-90012 C7769-90132 C7769-90032
Lithuanian C7769-90029 Not available Not available
Polish C7769-90024 Not available Not available
Portuguese C7769-90019 C7769-90139 C7769-90039
Russian C7769-90025 Not available Not available
Spanish C7769-90016 C7769-90136 C7769-90036

Next
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Language Pocket Guide User’s Reference Unpacking and
Guide Assembly poster
HP Part Numbers
Slovakian C7769-90030 Not available Not available
Taiwanese C7769-90013 C7769-90013 C7769-90033
Thai C7769-90026 Not available Not available
Turkish C7769-90027 Not available Not available

Previous
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Hardware
Item HP Part Number
JetDirect EIO Network Cards |10Base-T J3110A
10 Base2, 10-T J3111A
LocalTalk J3112A
Token Ring J4169A
10/100Base-TX
Spindle 610 mm - 24 inch C2389A
1067 mm - 42 inch C2390A
Stand 610 mm - 24 inch FL for 500 series C7782A
GR for 800 series C7781A
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Consumable Items
Item Color HP Supply No. |HP Part Number
Ink Black 10 C4844A
Cartridges Cyan C4911A
Yellow 82 C4913A
Magenta C4912A
Printheads  |Black C4810A
Cyan 1 C4811A
Yellow C4813A
Magenta C4812A

To achieve the best performance from your printer, we recommend you only use genuine Hewlett-Packard
accessories and supplies, whose reliability and performance have been thoroughly tested to give trouble-free

performance.
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Term Meaning
ANSI paper  An American standard paper size; e.g. D, E.

Architectural
paper

application
Centronics
clipping
CMP

CMYK
Coated
paper
default

device

dpi

The Architectural paper sizing system.

The software you use to create your drawings.
A standard for the parallel interface between computer and device.
Losing part of a drawing at the edges.

Complementary Media Program that helps HP customers grow their
businesses by referencing third-party printing material choices to ensure
maximum HP DesignJet printer flexibility and printing solutions.

Cyan, magenta, yellow and black. The colors of the printer’s four inks, and
also a standard color model.

Paper coated on one side for inkjet printing.

A value or condition that is assumed if no other value or condition is
specified.

An external item connected to the computer: printer, tape drive, etc. Your HP
DesignJet is a device.

Dots per inch, a measure of print resolution.

For More Terms, click on the Next Page Icon
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Term Meaning
drivers Software that controls the communication between a computer and a device.
front panel The control panel on the front right of the printer.
front panel The structure of options in the front-panel display.
menus
graphics A programming language telling a print device how to output graphic data.
language
grayscale Shades of gray to represent colors.
high-gloss A glossy, opaque photographic paper.
photo
HP-GL/2 One of Hewlett-Packard’s standard graphics languages for plotters and
printers. Produces vector data.
ICC Profile An International Color Consortium Device Profile.
I/O Input/ The transmission of data between a computer and a device.
output
IEEE-1284 A standard issued by the Institute of Electrical and Electronics Engineers

ink cartridge

(IEEE) as the Standard Signaling Method for a Bi-directional Parallel
Peripheral Interface for Personal Computers

The part of the HP Ink Supplies which contains all the ink used in the printer.
They are installed into the printer on the right side.

For More Terms, click on the Next Page Icon
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Term Meaning

inked area The smallest rectangle that contains all the content of the drawing, while
maintaining its relative dimensions.

ISO paper An international standard paper size; e.g. Al, A2, etc.

JIS A Japanese standard paper size.

LAN Local area network.

long-axis Printing a page when the length is longer than a standard page size.

printing

margin The space around the page added by the printer to separate one page from
another and to avoid printing right to the edge of the paper.

Nesting Placing two or more pages side-by-side on roll paper to avoid waste.

nozzles Located underneath the printhead. The nozzles direct the ink onto the page.

palette A set of logical pens defined by color and width.

PJL Printer Job Language. A programming language that controls jobs going to a
printer.

parallel A type of interface between computer and device. Generally faster than a

interface serial interface.

PANTONE The PANTONE MATCHING SYSTEM® is an international standard for color

communication in the graphics art industry.

For More Terms, click on the Next Page Icon
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Term Meaning
pen Even though the printer has no physical pens, the lines it draws match the
attributes of a pen.
platen The exterior part of the printer on which the paper rests before going into the
printer.
printhead The printhead is installed into the carriage assembly. It is the part which

printing area

PostScript

gqueueing

raster

Rendering
Intent

prints the ink onto the paper.
Page size minus margins.

Adobe PostScript is a computer language that describes the appearance of a
page, including elements such as text, graphics, and scanned images, to a
printer or other output device.

Placing each print received by the device into memory for processing with
other prints.

A method for defining an image, in terms of dots rather than lines. Raster
data typically needs more memory than vector data.

Rendering intent is a concept defined by ICC Spec ICC.1:1998-09, “File
Format for Color Profiles”.

From the specification: “Rendering intent specifies the style of reproduction
to be used during the evaluation of this profile in a sequence of profiles. It
applies specifically to that profile in the sequence and not to the entire
sequence. Typically, the user or application will set the rendering intent
dynamically at runtime or embedding time.”

For More Terms, click on the Next Page Icon
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Term Meaning
RGB Red, green and blue. A standard color model.
RIP Raster Image Processor.
RTL Raster Transfer Language is one of Hewlett-Packard’s standard graphics

languages for plotters and printers. Produces raster data.

For More Terms, click on the Next Page Icon
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Term Meaning

spindle The rod which holds the roll of paper.

paper-axis The vertical axis, as you look at the printer from the front in which the paper
feed moves.

scan-axis The horizontal axis, as you look at the printer from the front in which the print
carriage moves.

service The part of the printer which services the printheads. It keeps the printheads

station clean and stops them from drying out.

USB Universal Serial Bus.
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Printer does not Print - Troubleshooting
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Alignment Queue
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Replacement Description
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Loading = environmental
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Troubleshooting vellum

Procedure W
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animation
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